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„Sărbătorim împreună 
100 de ani de pasiune și 
excelenţă a acestei ţări“

THOMAS BACH, 
PREȘEDINTELE CIO, 
LA BUCUREȘTIȘ
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Pentru mulţi, IARU – Uniunea Internaţională 
a Radioamatorilor – este un simplu nume. Îl avem 
cu toţii pe undeva prin minte, dar nu mulţi radioa-
matori ştiu ce este şi ce face IARU. Sper ca acest 
articol să arunce o rază de lumină asupra muncii 
depuse de IARU, arătându-i importanţa pentru 
toţi radioamatorii.

IARU este portavocea comunităţii mondiale 
a radioamatorilor, din 1925 încoace. Colectivul 
IARU reprezintă interesele tuturor radioamato-
rilor la nivel internaţional şi regional, prin inter-
mediul ITU şi al organizaţiilor regionale de teleco-
municaţii, cum ar fi CEPT. Admiterea ca membru 
IARU este deschisă asociaţiilor naţionale repre-
zentative ale radioamatorilor din orice ţară.

IARU a fost creată în 1925 la Paris, unde 250 de 
delegaţi, reprezentând vreo 26 de ţări, s-au întrunit 
pentru a discuta întemeierea unei Uniuni Internaţi-
onale. În prezent, IARU cuprinde peste 160 de soci-
etăţi membre, reprezentând majoritatea radioama-
torilor din lumea întreagă.

IARU astăzi
Don Beattie, G3BJ, Preşedintele Regiunii 1 IARU 
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IARU astăzi
IARU este condusă de un preşedinte – în 

prezent, Tim Ellam, VE6SH. Ole Garpestad, 
LA2RR, este vicepreşedinte, iar amândoi sunt 
ajutaţi de un secretariat organizat de ARRL, 
care îl are în frunte pe  Rod Stafford, W6ROD, 
secretar internaţional.

IARU este organizată în 3 Regiuni, care 
oglindesc cele trei regiuni recunoscute de ITU. 
Acestea sunt:

Regiunea 1: Europa, Africa, Orientul Mijlo-
ciu şi Asia de Nord 

Regiunea 2: Americile
Regiunea 3: Asia-Pacific 
Fiecare Regiune este organizată separat în 

ceea ce priveşte finanţarea şi activităţile, dar 
toate trei lucrează alături de oficialii IARU 
atunci când se pune problema reprezentării 
radioamatorilor în relaţia cu ITU sau cu orga-
nizaţiile regionale de telecomunicaţii.

Politica IARU este definită de Consiliul de 
Administraţie, care cuprinde câte 2 reprezen-
tanţi din fiecare Regiune, alături de preşe-
dintele IARU, vicepreşedintele şi secretarul 
internaţional. Consiliul de Administraţie se 
întruneşte, fizic, o dată pe an, dar se întruneş-
te prin teleconferinţe de câte ori este nevoie. 

IARU este observator la ITU, organizaţia 
Naţiunilor Unite care elaborează regulamen-
tele radio internaţionale. Ca atare, IARU 
participă la luarea multor decizii adoptate de 
ITU, inclusiv în cadrul foarte importantelor 
Conferinţe Mondiale de Radio (World Radio-

communications Conferences – WRC), urmă-
toarea fiind planificată pentru sfârşitul anului 
2015. Prin aceasta, dar şi prin activitatea depu-
să la nivel naţional şi regional, IARU îşi rea-
lizează obiectivele în ceea ce priveşte protecţia 
şi perfecţionarea privilegiilor de bandă de care 
se bucură radioamatorii. 

Cele 3 Regiuni IARU au responsabilităţi 
deosebite în ceea ce priveşte conlucrarea cu 
organizaţiile regionale de telecomunicaţii. În 
cazul Regiunii 1, sunt 4 asemenea organizaţii: 
CEPT pentru Europa, ATU pentru Africa, 
ASMG pentru statele arabe şi zona Golfului şi 
RCC pentru CSI. Regiunea 2 conlucrează cu 
CITEL, care are responsabilităţi în America 
de Nord, Centrală şi de Sud, iar Regiunea 3, 
cu Asia Pacific Telecommunity.

Fiecare Regiune are propria sa conducere, 
Comitetul Executiv, şi organizează la fiecare 3 
ani o Conferinţă, pentru a-şi elabora politicile. 

Regiunea 1
IARU Regiunea 1 cuprinde 94 de asociaţii, 

de la cele cu o mână de membri la altele care 
regrupează zeci de mii de radioamatori. Cele 
mai mari 10 asemenea societăţi cuprind vreo 
77% din totalul membrilor Regiunii 1 – con-
form graficului 1. 

Regiunea 1 este condusă de un Comitet Exe-
cutiv format din 9 persoane, ajutat în munca sa 
de 15 grupuri de lucru şi de specialişti coordo-
natori. Membrii Comitetului Executiv şi gru-

 Germania
 Marea Britanie
 Italia
 Spania
 Olanda
 Franţa
 Suedia

Grafic 1
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purilor de lucru provin din societăţile membre 
ale Regiunii 1, iar numirea lor este hotărâtă la 
Conferinţa Generală a Regiunii, cu caracter tri-
enal. 

Regiunea 1 este foarte activă în diferitele co-
misii ale CEPT şi are, de asemenea, un Memo-
randum de cooperare ATU (African Telecom-
munications Union). În acest fel, Regiunea 1 
are un cuvânt de spus în luarea deciziilor care 
afectează radioamatorii şi poate lucra alături 
de colegii din CEPT pentru a dezvolta luări de 
poziţie sau propuneri în ceea ce priveşte Servi-
ciul de Amatori. 

Regiunea 1 este finanţată de subscripţiile so-
cietăţilor membre, care se situează în prezent 
la nivelul de 1,8 franci elveţieni pe an, pentru 
fiecare radioamator cu licenţă. 

Bugetul de cheltuieli al Regiunii 1 este sta-
bilit la Conferinţa Generală şi cuprinde o serie 
de capitole, conform graficului 2. 

Graficul arată că feliile cele mai consistente 

din buget sunt consacrate viitorului: ameliorarea 
spectrului alocat (ITU/RTO), protecţia benzi-
lor de radioamatori, dezvoltarea radioamatoris-
mului (ţări în curs de dezvoltare şi tineri radio-
amatori, în principal) şi sponsorizările. Toate 
acestea reprezintă cam 60% din cheltuieli. 10% 
reprezintă participarea la cheltuielile secretari-
atului internaţional, iar după deducerea onora-
riilor de audit şi comisioanelor, restul de 20% 
acoperă costul întrunirilor grupurilor de lucru 
şi cheltuielile administrative ale Comitetului 
Executiv, inclusiv în ceea ce priveşte site-ul web 
(www.iaru-r1.org).

Realizările IARU 
După ce am prezentat datele generale 

 despre IARU, e timpul să vorbim şi de reali-
zările noastre. În mod inevitabil, e nevoie de 
mult timp pentru a reuşi o ameliorare semnifi-
caitvă a spectrului alocat radioamatorilor, din 
moment ce procesul discutării şi adoptării mo-
dificărilor este mondial, detaliat şi de durată. 
Dar privind înapoi, iată ce am realizat:

  Extinderea benzii de 40m în Regiunea 1, 
pentru a include şi segmentul de la 7100 
kHz la 7200 kHz section;

  Alocarea către radioamatori a frecvenţei 
de 136 kHz;

  Alocarea către radioamatori a frecvenţei 
de 472 kHz;

  Încorporarea benzii de 4m în Tabelul 
European de Alocări Comune, ceea ce a 

The Region 1 Executive Committee
Don Beattie, G3BJ (President)
Faisal Al-Ajmi, 9K2RR (Vice President)
Dennis Green, ZS4BS (Secretary)
Eva Thiemann, HB9FPM (Treasurer)
Ranko Boca, 4O3A
Dave Court, EI3IO 
Thilo Kootz, DL9KCE
Ivan Stauning, OZ7IS
Oliver Tabakovski, Z32TO

 Meetings
 ITU & RTO
 Event sponsorship
 Spectrum protection
 Development initiatives
 IS support
 Admin
 Finance & audit
 WG costs

Grafic 2
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dat posibilitatea ţărilor care nu au acces 
la banda de 4m să contacteze organismele 
de reglementare, solicitând acces;

  Dezvoltarea T/R 61-02 şi 61/02 pentru 
roaming internaţional;

  Revizuirea Articolului 25 din Regula-
mentele Radio, renunţându-se la cerinţa 
expresă de a cunoaşte Morse şi efectuân-
du-se şi alte schimbări în ceea ce priveşte 
radiocomunicaţiile de urgenţă.

De asemenea, IARU a lucrat alături de Sec-
torul Dezvoltare din cadrul ITU în ceea ce 
priveşte comunicaţiile de urgenţă. Este lim-
pede că ITU consideră că radiocomunicaţiile 
de amator reprezintă o resursă semnificativă 
în caz de dezastru, de aceea am beneficiat de 
ajutorul ITU în promovarea argumentelor ra-
dioamatorilor în acest domeniu. 

Perspective de viitor 
IARU lucrează activ în cadrul ITU şi a orga-

nizaţiilor regionale de telecomunicaţii pentru 
a proteja şi dezvolta privilegiile de spectru de 
care se bucură radioamatorii. Ne confruntăm 
permanent cu ameninţări la adresa spectrului 
de radioamatori, şi nu numai din partea altor 
utilizatori, care solicită frecvenţe, ci şi datorită 
dispozitivelor non-radio care, prin funcţionarea 
lor, ridică nivelul de zgomot în spectrul radio. Şi 
pe viitor, IARU va încerca să protejeze spectrul 
alocat radioamatorilor şi-şi va spori implicarea 
în domeniul EMC.

Dar, pentru a fi cu adevărat eficientă, IARU 
are nevoie de ajutor activ din partea tuturor so-
cietăţilor membre. IARU poate să reprezinte 
în mod adecvat radioamatorii la nivelul ITU, 
dar ne bazăm pe echipele regionale pentru a 
fi reprezentaţi la nivelul organismelor regiona-
le de telecomunicaţii şi ne bizuim pe faptul că 
asociaţiile care compun echipele regionale vor 
şti să construiască relaţii apropiate, de muncă, 
cu administratorii naţionali ai spectrului radio. 
Degeaba ai reprezentanţi la nivelul CEPT dacă 
delegaţiile naţionale la CEPT nu sunt dinainte 
sensibilizate faţă de aspiraţiile Serviciului de 
Amatori. De aceea, o orientare importantă a 
anilor ce vin este încurajarea şi sprijinirea asoci-
aţiilor componente care nu au asemenea relaţii 
cu administraţiile respective, în sensul dezvol-

tării unor legături cât mai strânse şi eficiente. 
Aceasta e valabil nu numai în ceea ce priveşte 
nivelul administratorilor spectrului naţional, 
dar şi în ceea ce priveşte organizaţiile naţiona-
le din domeniul standardizării, unde se dezbat 
standardele EMC. Asociaţiile componente ar 
trebui să fie reprezentate la amândouă aceste 
niveluri şi ar trebui să dispună de reprezentanţi 
pricepuţi în a le susţine interesele.

Don Beattie are indicativul de radioamator 
G3BJ şi indicativul de concurs G5W, fiind foar-
te activ în competiţiile internaţionale. Operea-
ză pe toate benzile, de la 1.8 MHz la 50 MHz. 
A fost preşedinte al Radio Society of Great 
Britain, a activat o vreme ca manager general al 
RSGB, apoi a fost Secretar al Regiunii 1 IARU. 
Este vicepreşedinte pe viaţă al RSGB. A fost 
ales preşedinte al Regiunii 1 IARU în septem-
brie 2014.

Don crede cu tărie în beneficiile pe care ra-
dioamatorismul le aduce relaţiilor naţionale şi 
internaţionale şi consideră că IARU are un rol 
deosebit de important în definirea viitorului ra-
dioamatorismului. 

Region 1 Working Groups and Coordinators
  HF Committee – Ulrich Mueller, DK4VW
  VHF/UHF Committee – Jacques Verleijen, 

ON4AVJ
  External Relations Committee – 

Colin Thomas, G3PSM
  EMC Committee – Christian Verholt, 

OZ8CY
  IARU Monitoring System – Wolfgang 

Hadel, DK2OM
  Political Relations Committee – 

Thilo Kootz, DL9KCE
  Emergency Comms Co-ordinator – 

Greg Mossop, G0DUB
  Youth WG – Lisa Leenders, PA2LS
  Amateur Radio Space Exploration WG - 

Stefan Dombrowski, ON6TI
  STARS WG – Jean-Jacques Niava, TU2OP
  AR Direction Finding WG – Jiri Maracek, 

OK2BWN
  High Speed Telegraphy WG – Ivan Ivanov, 

LZ1PJ
  Regulatory Aff airs – Peter Frey, HB9MQM
  Beacon coordinator – Martin Harrison, 

G3USF
  Observation Service – Mark Jones, G0MGX
  Information Programme for Handicapped 

Radio Amateurs – Riri Razrak, OD5RI
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Conferinţa generală trienală IARU 
Regiunea 1 a avut loc în perioada 
21–25 septembrie 2014 în oraşul 
Albena din Bulgaria, pe malul Mării 
Negre. Prima şedinţă plenară, 
de la deschiderea conferinţei, a 
fost condusă de preşedintele şi 
vicepreşedintele IARU şi a reunit 
aproximativ 150 de delegaţi, 
reprezentând societăţile de 
radioamatori din 60 de ţări ale 
Regiunii I, precum şi delegaţii 
Regiunilor 2 şi 3.

În afara aspectelor protocolare – discur-
surile de bun-venit ale oficialităţilor bulgare 
(ministrul telecomunicaţiilor), preşedintelui 
IARU şi preşedintelui Regiunii 1 a IARU – au 
reţinut atenţia două intervenţii, pe subiecte de 
mare interes:

- o intervenţie video a dr. Hamadoun I. 
 Touré, HB9EHT, secretar general al Uniu-
nii Internaţionale de Telecomunicaţii (ITU), 
transmisă prin intermediul staţiei 4U11TU, în 
care acesta a reiterat sprijinul său pentru ra dio-
amatori, prin intermediul IARU, şi a insistat 
asupra importanţei pregătirii conferinţei WRC 
2015, având în vedere perspectiva atribuirii de 
noi benzi serviciului de radioamator (cu trimi-
tere în special la banda de 5 MHz – 60m).

- Intervenţia consilierului comisarului eu-
ropean bulgar Kristalina Gheorghieva, care 
a prezentat în termeni elogioşi contribuţia 
radio amatorilor la serviciile de urgenţă, pe 
care le-au sprijinit în multiple moduri.

Conferinţa a continuat cu lucrările pe comi-
tete, după cum urmează:

COMITETUL C2 (Financiar)
Şedinţele comitetului au permis punerea la 

punct a bugetului IARU Regiunea 1 pentru 
anii 2015-2017, inclusiv fondurile necesare or-
ganizării Reuniunii trienale din 2017. Obiecti-
vul principal a fost ţinerea sub control sau chiar 
reducerea costurilor, pe fondul unei atenţii spo-
rite acordate câtorva scopuri strategice:

  Apărarea benzilor de frecvenţă la nivelul 
instituţiilor europene şi internaţionale;

  Acţiunile consacrate tinerilor (YOUTH, 
YOTA), precum şi cele consacrate ţări-
lor care încep să-şi constituie structuri şi 
să desfăşoare activităţi radioamatoriceşti 
(STARS).

COMITETUL C3 
(Administrare şi Organizare)

Au fost prezentate rapoarte din partea a nu-
meroase grupuri de lucru, privind activitatea 
comitetelor de relaţii publice (PRC) şi a co-
mitetelor de relaţii externe (ERC) în ceea ce 
priveşte menţinerea legăturilor cu instituţiile 
regionale şi internaţionale (IUT, CEPT, Uniu-
nea Europeană) şi participarea lor la şedinţele 
diferitelor organisme cum ar fi:

  Grupul RSPP al Comisiei Europene, care 
lucrează la realocarea unor benzi de frec-
venţă către banda mobilă extinsă;

  CEPT şi grupurile sale de lucru, care pre-
gătesc CMR 2015, ce se va desfăşura la 
Geneva;

CONFERINŢA IARU 
REGIUNEA 1 DE LA VARNA/

ALBENA, BULGARIA
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  Organizarea reţelelor de comunicaţii de 
urgenţă de radioamator, pe ţări; s-a pro-
pus organizarea anuală a unei conferinţe 
europene dedicate acestui subiect, simila-
ră GAREC;

  Gestionarea şi sortarea QSL-urilor;
  Stadiul proiectelor STARS şi crearea (în 
curs sau deja înfăptuită), în mai multe sta-
te africane, a unor structuri asociative de 
radioamatori;

  Crearea unui Comitet permanent dedicat 
compatibilităţii electromagnetice (CEM), 
sens în care s-a discutat modul de organi-
zare a acestuia;

  Participarea la programele consacra-
te tineretului (YOUTH şi YOTA – 
 „Youngsters On the Air“), care se dezvol-
tă rapid, sens în care finanţarea este din 
nou asigurată de bugetul IARU Regiunea 
1, fiind preconizată formarea, la acest ni-
vel, a unui grup de lucru dedicat;

  Legăturile prin sateliţi şi contactele 
ARISS (peste 900 realizate în Regiunea 
1, de începutul anilor 2000).

Cu acest prilej, Don Beattie – G3BJ şi  Michael 
Kasteloc – OE1MCU şi-au prezentat candida-
tura la postul de preşedinte al Regiunii 1.

COMITETUL C4 (HF)
Au fost prezentate de DARC, NRRL şi 

 OeVSV mai multe propuneri de extindere a 
benzii de 10 MHz, în ceea ce priveşte modu-
rile digitale. În prezent, banda de 30m ne este 
atribuită cu statut secundar, cu obligaţia de a 
nu cauza interferenţe care să deranjeze utili-
zatorii primari – situaţie care se află în atenţie, 
ceea ce ne impune un comportament riguros. 
Propunerile de extindere a benzii au fost clasa-
te, în condiţiile în care participanţii s-au arătat 
reticenţi la ideea altor porţiuni de bandă alo-
cate modurilor digitale.

În ceea ce priveşte combaterea QRM-ului 
agresiv, s-a hotărât ca aceasta să facă obiectul 
cooperării între asociaţiile naţionale.

Proiectul creării unui comitet sportiv radio-
amatoricesc nu a întrunit unanimitatea.

Raportul EMERCOM a repertoriat frec-
venţele folosite în statele Regiunii 1 pentru ra-
diocomunicaţiile de urgenţă, acestea fiind cele 
comunicate oficial de către respectivele asoci-
aţii naţionale, pentru ca să se evite blocarea 
lor cu prilejul unor eventuale exerciţii.

G3USF, Martin Harrison, responsabilul cu 
balizele HF, şi-a prezentat raportul de activi-
tate, care a fost apreciat ca excelent, comitetul 
propunându-l pentru acordarea unei medalii.

DARC a prezentat propuneri de extindere 
a porţiunilor „fără contest“ din banda de 40m, 
dar subiectul a stârnit o dezbatere în urma că-
reia propunerea a fost retrasă.

În ceea ce priveşte staţiile operate de la 
distanţă (remote), un grup de lucru constituit 
ad-hoc a prezentat proiecte de îmbunătăţire a 
celor două propuneri prezentate de IRTC.

A fost luată în discuţie propunerea ARI de 
modificare a două puncte din regulamentul 
IARU HF Contest; acest concurs este gesti-
onat de IARU, care delegă administrarea sa 
către ARRL. S-a decis menţinerea actualului 
barem de punctare.

COMITETUL C5 
(VHF, UHF, microunde)

Dintre aspectele discutate: 
Se eliberează benzile de frecvenţă dintre 30 

şi 70 MHz, ceea ce deschide posibilităţi reale 
de atribuire de noi benzi.

Se semnalează proiectul unui satelit geo-
sta ţionar echipat cu un transponder de radio-
amatori, care să acopere întreaga Regiune 1.

S-a reamintit statutul nostru secundar în 
banda de 23 cm, ceea ce ne obligă să ţinem 
sub control interferenţele, utilizatorul primar 
având căderea să ne ceară încetarea emisiu-
nilor. Pentru a evita incidentele dezagreabile 
cu alte servicii cu care împărţim această ban-
dă, s-a decis reanalizarea transmisiilor TV de 
amator, deşi problema nu se limitează la aces-
tea, ci afectează toate transmisiunile continue 
de bandă largă.
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Alte subiecte discutate:
  Crearea unui nou tip de contest pentru 
benzile de 2m şi 70cm, în reprize de 6 ore 
(single şi multi), urmând a fi definite ca-
tegoriile.

  Modificări de mică anvergură ale bandpla-
nurilor.

  Banda de 2,3 GHz: căutarea de soluţii co-
mune care să ţină cont de evoluţia viitoa-
re a reglementărilor.

  Problema auto-spotting-ului în contest.
  La concursurile VHF şi mai sus, proce-
dura de alcătuire şi limita de timp pentru 
transmiterea raportărilor participanţilor 
şi a societăţilor naţionale.

  Modalităţile de coordonare a intrărilor şi 
ieşirilor pe releu în zonele de frontieră.

Comitetul a prezentat, de asemenea, sinte-
zele alcătuite de diferitele grupuri consultative 
de lucru asupra următoarelor probleme:

  TV amator în benzile de 70 cm şi 23 cm.
  Balizele sincronizate pe 50 MHz (au fost 
prezentate diferite soluţii tehnice).

  Regulile generale de desfăşurare a con-
cursurilor IARU VHF/UHF/SHF şi cele 
ale noilor concursuri în 50 MHz şi 70 
MHz.

  DARC a făcut o prezentare a reţelei In-
tranet radioamator HAMNET.

GRUPUL DE LUCRU CEM
Lucrările au vizat în principal activitatea de 

standardizare a produselor de către diferite or-
ganisme dedicate (CISPR, ETSI, CENELEC 
etc.) S-a recomandat ca specialişti din cadrul 
asociaţiilor naţionale să participe la elabora-
rea standardelor, în paralel cu acţiuni de lobby 
la adresa respectivelor instituţii.

REUNIUNEA CU ŢĂRILE 
AFRICANE

Asociaţiile africane de radioamatori solicită 
legături mai strânse cu REF şi cu Franţa. Noi 
asociaţii iau fiinţă, altele se extind, de aceea 
este nevoie de ajutor în ceea ce priveşte edu-
caţia tehnică şi expertiza în domeniul radio. A 
fost organizată o reuniune de lucru, cu partici-

parea Franţei şi a asociaţiilor de radioamatori 
din Algeria, Burkina-Faso, Camerun, Coasta 
de Fildeş, Mali şi Senegal, dar şi a reprezen-
tanţilor Principatului Monaco. A fost elaborat 
proiectul unui acord de colaborare între ţările 
francofone din Regiunea 1 IARU.

REUNIUNEA PLENARĂ a încheiat lu-
crările conferinţei. Au fost aprobate rapid ma-
joritatea textelor elaborate şi concordate la ni-
velul grupurilor de lucru. Numai unele dintre 
ele au făcut obiectul unor discuţii, obiecţiile 
având caracter formal.

În ceea ce priveşte organizarea viitoarei 
conferinţe trienale (2017), 3 ţări şi-au anunţat 
candidatura:

  Germania a propus localitatea Wildbad 
Kreuth, din Bavaria, la 100 km sud de 
München;

  Irlanda s-a oferit să găzduiască conferin-
ţa, în apropierea aeroportului din Dublin 
(coasta de Est);

  Serbia a propus oraşul Novi Sad, de lângă 
Belgrad.

Cu o netă majoritate a fost aleasă localita-
tea din Bavaria.

A urmat alegerea Comitetului 
Executiv al IARU Regiunea 1:

Oficiali

G3BJ, Don Beattie, preşedinte
9K2RR, Faisal Alajimi, vicepreşedinte
HB9FPM, Eva Thiemann, trezorier
ZS4BS, Dennis Green, secretar

Membri

DL9KCE Thilo Kootz
EI3IO David Court
4O3A Ranko Boca
OZ7IS Ivan Stauning
Z32TO Oliver Tabakovski
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Chiar dacă anul 2014 nu a 
reprezentat un an la fel de bogat 
în rezultate internaţionale ca 
cel precedent, trebuie să privim 
lucrurile dintr-un alt punct de 
vedere, cel al performanţelor la nivel 
naţional. Putem considera acest 
an, un an al schimbărilor, un an al 
intrării pe o direcţie pozitivă.

În acest an toate competiţiile s-au desfăşu-
rat după noul regulament al Campionatelor 
Naţionale aprobat de către FRR în luna mar-
tie. Noul regulament este unul modern, aliniat 
la regulamentele internaţionale IARU ARDF 
şi deşi nu este perfect, reprezintă o bază de la 
care se poate ajunge la un regulament cât mai 
corect şi care să susţină performanţa.

În luna mai am avut după mulţi ani un can-
tonament naţional dedicat juniorilor sub 14 
ani. Cantonamentul s-a desfăşurat pe terenu-
rile de concurs Bejan şi Căprioara din Deva, 
judeţul Hunedoara. Tinerii sportivi au avut 
atât antrenamente fizice, cât şi antrenamente 
tehnico-tactice.

Numărul Maeştrilor Sportului s-a mărit cu 
patru nume noi: Babeu Alexandru (CS Muni-
cipal Târgovişte), Bilan Maria, Bilan Loredana 
şi Olah Marcel (toţi trei CS Sky-Lark Medieşu 
Aurit), numărul total al Maeştrilor ai Sportu-
lui ajungând la 15.

Poate cea mai importantă performanţă la 
nivel naţional a fost numărul mare de partici-

panţi la Campionatele Naţionale Individuale, 
Sprint şi Foxoring organizate în septembrie la 
Craiova, unde au participat nu mai puţin de 
45 de sportivi de la 7 cluburi sportive. Acest 
număr include doar sportivi de la categoriile 
de 19 ani sau mai mari. Anul 2014 este anul 
cu cea mai mare participare la un Campionat 
Naţional din ultimii 10 ani:

 2013 – 37 participanţi
 2012 – 36 participanţi
 2011 – 44 participanţi (trebuie avut în ve-
dere că acest număr conţine şi juniorii de 
la categoriile de 14 şi 16 ani, la categoriile 
de la 19 ani în sus fiind 27 participanţi)
 2010 – 42 participanţi (trebuie avut în ve-
dere că acest număr conţine şi juniorii de 
la categoriile de 15 ani, la categoriile de la 
19 ani în sus fiind 33 participanţi)
 2009 – 51 participanţi (trebuie avut în ve-
dere că acest număr conţine şi juniorii de 
la categoriile de 15 ani, la categoriile de la 
19 ani în sus fiind 38 participanţi)
 2008 – 38 participanţi
 2007 – 41 participanţi
 2006 – 41 participanţi
 2005 – 47 participanţi (trebuie avut în ve-
dere că acest număr conţine şi juniorii de 
la categoriile de 15 ani, la categoriile de la 
19 ani în sus fiind 38 participanţi)
 2004 – 61 participanţi

* statistică realizată pe baza rezultatelor ofici-
ale de la Campionatele Naţionale

Din luna septembrie, România se mândreş-
te cu trei arbitri internaţionali după ce Babeu 
Pavel a devenit arbitru internaţional, fiind 

Radio Orientarea 
în 2014

Olah Marcel, YO5OVS
Reprezentant FRR în cadrul Grupului de Lucru ARDF al IARU
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validat în cadrul şedinţei Grupului de Lucru 
ARDF al IARU Regiunea 1 din Kazakhstan.

Ca rezultate internaţionale, amintim urmă-
toarele:

  Campionatele Balcanice, Krushevo, 
Macedonia

  Medalii de aur: Marcu Valentina 
(F14), Creţan Simona (F35), Gher-
ghescu Alexandru (M19)

  Medalii de bronz: Babeu Alexandru 
(M21), Marcu Adrian (M40), Babeu 
Pavel (M50)

  Campionatele Europene de Tineret
  Individual: 
  locul 5 - Anghelescu Claudiu 

(Sprint)
  Echipe:
  locul 4 – Marcu Valentina şi Mija 

Denise (F14 – 80m)

  locul 5 – Marcu Valentina şi Mija 
Denise (F14 - 2m)

  locul 4 – Voicu Răzvan şi Claudiu 
Anghelescu (M14 - 2m)

  locul 4 – Voicu Răzvan şi Claudiu 
Anghelescu (M14 - 80m)

Mulţumim domnilor Dionisie Roşca, Olah 
Szabolcs şi Cuibuş Iosif pentru organizarea de 
la Campionatele Naţionale, domnului Marcu 
Adrian pentru eforturile de a deplasa la fie-
care competiţie un număr mare de sportivi, 
domnului Traian Tudurean care se încăpăţâ-
nează să fie prezent la fiecare concurs în ciuda 
problemelor financiare, domnului Pantilimon 
Marius pentru suportul dat an de an acestui 
sport şi domnului Babeu Pavel care luptă cu 
înverşunare ca fiecare competiţie să aibă un 
nivel cât mai ridicat. Mulţumim celor din Ora-
viţa pentru că au început să participe din nou 
la competiţii.
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Prezentarea aparatului

Receptorul prezentat este un aparat de re-
cepţie pe 3,5 MHz folosit pentru concursurile 
de Orientare Radio proiectat şi realizat în ca-
drul Clubului Sportiv Skylark Medieşu Aurit. 
La proiectarea şi realizarea aparatului, obiec-
tivul principal a fost simplitatea atât din punct 
de vedere constructiv, cât şi din punct de vede-
re al realizării practice, dar cu asigurarea pa-

rametrilor de funcţionare superiori. Cu acest 
tip de aparat s-au obţinut rezultate valoroase 
la diferite concursuri.

Funcţionarea receptorului

Din punct de vedere funcţional, este un 
receptor cu conversie directă, având un etaj 
preamplificator realizat cu tranzistorul mosfet 

RECEPTOR ARDF 
PE 3,5 MHz CU 

CONVERSIE DIRECTĂ
IOSIF CUIBUŞ YO5AT

Figura 1
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cu 2 porţi prin care se realizează şi reglarea 
sensibilităţii de recepţie prin modificarea ten-
siunii la poarta G2 a tranzistorului mosfet de 
tipul BF964.

Semnalul recepţionat intră pe poarta G1 a 
tranzistorului prin intermediul circuitului acor-
dat pe 3,5 MHz. Semnalul amplificat intră în 
circuitul acordat tot pe 3,5 MHz bine ecranat 
pentru ca recepţia să fie numai prin circuitul de 
intrare realizat pe bara de ferită cu diametru de 
10 mm şi lungime de 100 mm (antenă de ferită). 
Semnalul astfel amplificat intră în circuitul in-
tegrat de tip SA612 care funcţionează ca mixer 
şi oscilator local, frecvenţa căruia este acorda-
tă pe frecvenţa de lucru a staţiilor de concurs 
(conversie directă). Semnalul de audiofrecven-
ţă obţinut după mixare trece mai departe prin 
filtru LC, trece jos la amplificatorul final reali-
zat cu circuitul integrat de tip LM386N.

La ieşire este cuplată o cască cu impedan-
ţa cuprinsă între 16-300 Ohmi. Sensibilitatea 
receptorului, cât şi acordul se realizează cu 
potenţiometrele de 50 kOhmi montate direct 
pe placa circuitului imprimat. Pentru realiza-
rea funcţionării stabile a aparatului, circuitul 

integrat SA612 se alimentează cu tensiunea 
stabilizată de 6V realizată cu stabilizatorul 
LM78L06.

Alimentarea receptorului este asigurată de 
o baterie de 9V. Având în vedere folosirea 
componentelor moderne şi cu consum redus, 
consumul total al receptorului este de cca. 
18mA, ceea ce asigură o funcţionare îndelun-
gată a aparatului.

Pentru posibilitatea măsurării direcţiei sta-
ţiilor de concurs, la antena de ferită s-a adap-
tat şi o antenă baston cu o lungime de cca. 
160 mm care se cuplează cu antena de ferită 
prin intermediul unui tranzistor PNP de tipul 
BC556B. Întrucât această antenă nu trebuie 
să fie permanent cuplată cu antena de ferită, 
ea se cuplează numai dacă pushbutonul este 
apăsat. Schema de principiu este prezentată 
conform figurii 1.

Realizarea practică a receptorului

Receptorul se realizează pe un circuit im-
primat de 30x138mm, placă dublu placat, care 

Figura 2

Figura 3
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este prezentat în figura 2, iar montarea piese-
lor cu valorile marcate se poate urmării con-
form figurii 3. Cutia aparatului este făcută din 
tablă de aluminiu cu grosimea de 1,5 mm ca în 
figurile 4 şi 5. După rea lizarea plăcii de circuit, 
găurirea se execută cu burghiu de 0,9 mm întâi 
a acelor găuri care sunt în legătură cu trasee-
le de circuit, după care se întoarce placa şi se 
zencuiesc găurile cu un burghiu de 3 mm. Apoi 
se găuresc restul de puncte cu cercuri mai mici 
pe placă şi acele puncte legate între ele, la care 
cercurile sunt marcate cu o liniuţă. Aceste gă-
uri nu mai trebuie zencuite deoarece lipiturile 

la masă se fac pe partea opusă a circuitului (pe 
masa comună).

Din punctul de vedere al montării pieselor 
pe placă, trebuie scoase în evidenţă cele două 
bobine ecranate L3 şi L4 care se realizează pe 
carcasa unui circuit de medie frecvenţă de 10,7 
MHz cu dimensiuni de 8x8 mm. Bobina prima-
ră L3 are 8 spire din sârmă de 0,12 mm diame-
tru cu izolaţie de email. Bobina secundară L4 
are 25 spire bobinate peste L3 din aceeaşi sâr-
mă. Bobina L5 a oscilatorului local este reali-
zată pe carcasa unui circuit de medie frecvenţă 
de 10,7 MHz cu dimensiunile de 10x10 mm, 

LISTA DE COMPONENTE
C1 = 43n
C2 = 22
C3 = 12
C4 = 3-30
C5 = 43n
C6 = 43n
C7 = 100n
C8 = 43n
C9 = 82p
C10 = 100
C11 = 100 
C12 = 100n 
C13 = 300
C14 = 300
C15 = 22n 
C16 = 100n 
C17 = 100
C18 = 100
C19 = 68 
C20 = 100n 
C21 = 22n
C22 = 33n 
C23 = 4,7μ 
C24 = 47n
C25 = 1μ 
C26 = 100n 
C27 = 220μ 
C28 = 43n
CD1 = BB139 
D1 = 4148
D2 = 4148 

IC1 = SA612 
IC2 = LM386N

L1 =
L2 =
L3 =
L4 =
L5 =
L6 =
L7 =

P1 = 22k
P2 = 50k
P3 = 50k

R1 = 470k
R2 = 100
R3 = 10k
R4 = 100
R5 = 1k
R6 = 4,7k
R7 = 220k
R8 = 10k
R9 = 100k
R10 = 3,3k
R11 = 10
R12 = 47k

T1 = C556B
T2 = BF964

Figura 4
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având înfăşurate 26 spire din sârmă de 0,12-
0,15 mm. În rest, montarea componentelor nu 
prezintă greutăţi.

Se montează placa în cutie aşa cum se vede 
pe figura 4 (RXa) fixând-o cu piuliţele celor 2 
potenţiometre folosind distanţiere ca lipiturile 
pieselor să fie distanţate de suprafaţa cutiei. 
Aşa cum s-a arătat mai sus, antena de ferită 
se realizează pe o bară de ferită de 10 mm di-
ametru şi 100 mm lungime, bobinând 22 spire 
din sârmă de 0,5 mm cu izolaţie de email în aşa 
fel ca bobina să fie în mijlocul barei, apoi peste 
această bobină se înfăşoară bobina de cuplaj 
pentru antena baston având 2 spire din sârmă 
liţata cu izolaţie din PVC.

Bara de ferită împreună cu bobinele se in-
troduc într-un tub din PVC cu diametrul de 
22-25 mm. Fixarea barei de ferită la mijlocul 
interior al tubului se poate realiza cu burete 
sau cu distanţiere de cauciuc. La cele 2 cape-
te ale tubului PVC se pun dopuri pentru a nu 
intra umezeala în interiorul tubului. Mijlocul 
tubului din PVC se găureşte pentru scoaterea 
capetelor bobinelor care se introduc în cutia 
receptorului printr-o gaură. Tubul PVC se fi-
xează de cutia receptorului printr-o clemă nu-
mai într-o latură ca să nu formeze o spiră de 
scurtcircuit peste bara de ferită. Antena bas-
ton se montează izolat de cutia receptorului.

 

Punerea în funcţiune 
şi reglarea

După asamblarea şi montarea în cutie a tu-
turor componentelor inclusiv a bateriei de 9V, 
cuplarea bateriei se realizează numai după ce 
casca este introdusă. Se verifică dacă nu este 
vreun scurtcircuit prin legarea în serie cu ba-
teria unui miliampermetru. Dacă totul este în 
ordine, în cască trebuie să se audă un fâsâit oa-
recare.

Se pune în funcţiune o staţie de concurs şi 
se reglează bobina L5 până ce se aud semnale-
le staţiei. Apoi se reglează bobina L4, cu care 
ocazie trebuie să gasim un punct maxim de au-
diţie. După aceasta se reglează condensatorul 
trimer de 3-35 pF la fel până ce creşte audi-
ţia la maxim în cască. Dacă totul funcţionează 
fără probleme, se verifică reglajul sensibilităţii 
cu potenţiometrul de 50 kOhmi într-o gamă 
largă de audiţie. Acordul frecvenţei cu poten-
ţiometru de 50 kOhmi trebuie efectuat în aşa 
fel ca să cuprindă frecvenţele între 3490 kHz şi 
3650 kHz.

Reglarea antenei baston pentru realizarea 
diagramei de cardioidă a directivităţii se face 
cu potenţiometrul semireglabil de 22 kOhmi. 
După efectuarea acestor reglaje receptorul 
este gata pentru concurs.

Figura 5
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1. Introducere
Nu este radioamator care să nu ştie ce este 

un QSL şi obligaţia morală de a confirma o 
legătură cu un partener de QSO. Cu toate că 
există metode moderne de confirmare a legă-
turilor radio prin Internet în site-uri, baze de 
date specializate, cum ar fi eQSL sau LOTW, 
o bună parte din legături sunt confirmate prin 
„paper QSL“, cărţi de confirmare „model car-
te poştală - vedere“, foarte frumoase şi sem-
nificative. Ele constituie colecţii importante 
generatoare de diplome şi clasamente de per-
formanţă în domeniul comunicaţiilor radio.

Odată cu apariţia calculatoarelor şi a progra-
melor de evidenţă a legăturilor în fişiere de tip 
LOG, completarea manuală a informaţiilor re-
levante în „paper QSL“ a diminuat în favoarea 
tipăririi unor etichete care confirmă principalii 
parametri ai legăturii radio şi care se lipesc în 
locuri special rezervate pe suprafaţa QSL-urilor.

Programul BV7 al radioamatorului german 
DF3CB Bernd Koch oferă instrumentele nece-
sare proiectării şi generării de etichete tipăribi-
le la imprimantele ataşate calculatoarelor PC.

2. Acţiuni preliminare
  Analizaţi dimensiunea etichetei pe care do-
riţi să o lipiţi pe QSL - funcţie de formatul 
şi locul rezervat acesteia pe QSL.

  Dacă nu aţi tipărit încă QSL-ul, este util să 
vă alegeţi etichete autoadezive de dimensi-
une standard existente în comerţul de pape-
tărie şi mai apoi să concepeţi QSL-ul cu un 
spaţiu rezervat etichetei. Este bine ca acest 
spaţiu să fie tipărit cu rubricile standard ne-
cesare confirmării manuale a unei legături 
în lipsa etichetelor sau din dorinţa de a face 
o confirmare specială „personalizată“.

  Unele din dimensiunile uzuale standard 
pentru 21 sau 24 de etichete pe o pagină 
A4 sunt:

  A4/21 - 70x41 mm
  A4/21 - 70x42,4 mm
  A4/24 - 70x36 mm
  A4/24 - 70x37 (70x37,13) mm
  A4/24 - 70x35 mm

  O cutie cu 100 de pagini A4 cu 24/pag. cos-
tă 29,90 lei la „depozitul de papetărie“ în 
YO3 adică 2400 de etichete, 2990 bani/2400 
etq = 1,25 bani/etq.

  Foarte important! Ca să tipăriţi etichetele 
trebuie să verificaţi funcţionarea impriman-
tei dvs. De regulă imprimantele nu pot folosi 
întreaga suprafaţă a paginii A4. La intrarea 
foii în imprimantă rămâne nefolosit un spa-
ţiu (din lungimea foii) de „apucare / trage-
re“. La ieşirea paginii din imprimantă de 
asemenea rămâne un spaţiu nefolosit care 
poate fi foarte mare, de până la 1-2 cm.

3. Scurtă descriere a aplicaţiei
1. Este gratuită.
2. Funcţionează sub Windows XP, Vista, 

7 şi 8.
3. BV7 se instalează obligatoriu cu programul 

auxiliar Borland Database Engine - BDE.
4. Acceptă 1.490 de formate de etichete de la 

31 de mari producători.

BV7 – Program pentru 
tipărirea etichetelor QSL

Cristian Colonati YO4UQ
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5. Se pot tipări QSO-uri multiple ale aceluiaşi 
indicativ cu informaţii radio diferite pe o 
aceeaşi etichetă.

6. Se ignoră QSO-urile identice.
7. Construcţia logului şi tipărirea se face în 

ordinea alfabetică a entităţilor radio (bi-
rouri QSL) sau prin selecţie punctuală din 
logul încărcat.

8. După alegerea formatului etichetei se poa-
te face proiectarea detaliată a câmpurilor şi 
textelor.

9. BV7 are manual complet de 82 de pagini în 
limbile engleză, germană şi rusă.

10. Aplicaţia acceptă încărcarea în baza de 
date proprie (logul specific pentru tipărit 
etichete) numai in formatul ADIF. Progra-
mele de largă circulaţie care pot genera for-
mat ADIF pot fi: CT, NA, TRLog, HRD, 
N1MM ş.a. Pentru prezentul material s-a 
lucrat cu exportul ADIF din Ham Radio 
Deluxe V5.1.

Toate caracteristicile aplicaţiei le găsiţi în lim-
ba română şi la adresa http://yo4uq.jimdo.com în 
pagina de Cărţi & Articole. Vom încerca să dăm 
informaţiile practice şi unul sau mai multe video 
tutoriale care să ajute la construcţia şi tipărirea 
etichetelor.

Cred că toată lumea a văzut cum arată o eti-
chetă pentru confirmarea unei legături radio, 
lipită pe QSL. Proiectarea etichetelor depinde 
şi de câmpurile existente în salvarea ADIF din 
aplicaţia de log existentă la fiecare radioama-
tor. De exemplu, HRD V5.1 (release) poate 
seta şi salva informaţii ale mai multor câmpuri 
din QSO-uri decât cele strict necesare unei 
confirmări cum ar fi: numele corespondentu-
lui, locatorul, QTH-ul, frecvenţa exactă şi al-
tele. Unele dintre ele pot fi înscrise şi ele în 
textele din etichetă.

4. Descărcarea programului 
şi manualului

Descărcarea se face din site-ul autorului 
DF3CB în folderul deschis cu numele BV7 din 
My Documents: http://www.df3cb.com/bv care 
este pagina de Download.

  BDEInfoSetup.exe 6,9 MB BDE installati-
on program

  bv7_setup.exe 1,6 MB installation program
  bv7_manual.zip 453 kB manualul într-una 
din limbile engleză, germană sau rusă.
Pentru a evita confruntarea cu manualul 

vom încerca o prezentare pas cu pas care să 
permită realizarea unei etichete. Pentru cei 
care doresc să descopere toate valenţele pro-
gramului pot consulta cu încredere manualul.

5. Instalare BV7
  Cu SO Windows 7 Ultimate se instalează 
prima dată BDE urmând paşii cu Next.

  BDE - Borland Database Engine s-a insta-
lat în Program Files > Borland > Common 
Files > BDE cu toate componentele sale. 
Nu a fost constatată nici o anomalie de in-
stalare.

  bv7_setup > Run > User Account Control 
Yes > Next > C:\Program Files\BV QSL 
Labels Next > Install > Finish, iar cu un 
click dreapta pe BV7 Application facem un 
„Create Shortcut“ pe „desktop“ > YES şi 
am terminat instalarea.

6. Lansare în execuţie
Dublu click pe iconul BV7 din ecran şi apare 

întrebarea dacă doriţi crearea unui log. Dacă 
se dă Yes apare fereastra New Log în care in-
troduceţi indicativul dumneavoastră şi apăsaţi 
butonul Start Conversion > Close. În acest 
moment se face conversia fişierului în format 
ADIF în fişierul de log model BV7 din care se 
vor construi etichetele. Fişierul ADIF poate fi 
cel numit „sample“ oferit ca antrenament de 
BV7 sau un fişier ADIF salvat din aplicaţia de 
log cu care lucraţi şi pentru care doriţi să gene-
raţi etichete. Apar pe ecran cele două ferestre 
de lucru:

  BV7_QSL Management and Label/QSL 
Printing by DF3CB 7.9.2

  BV QSL Label Designer

Prima fereastră gestionează baza de date 
de log în formatul BV7 iar cea de-a doua asi-
gură proiectarea textului etichetei în formatul 
celei alese de dvs din „comerţul de papetărie“ 
şi în funcţie de dimensiunea spaţiului alocat 
pe QSL şi funcţionalitatea imprimantei, adică 
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spaţiile pierdute la tipărire. Nu este necesară 
menţinerea ambelor ferestre pe ecran. Sunt 
comenzi în meniu cu care se poate trece  dintr-o 
fereastră în alta (Windows > Label Designer 
Window sau CTRL+D iar invers File > Back 
to Log Window sau Alt+X). Acest lucru este 
necesar în operaţiunile de adaptări, corecţii şi 
verificări.

7. Operarea Logului BV7
Aşa cum s-a menţionat, se poate încărca un 

log generat în orice aplicaţie numai în format 
ADIF clasic. Aplicaţia personală generatoare 
de log trebuie să ştie să facă „Export“ în for-
mat ADIF.

BV7 face conversia între formatul ADIF 
aşa cum a fost salvat (exportat) din aplicaţia de 
origine, care a construit logul (exemplu HRD 
V5.1) cu toate rubricile existente în logul de 
origine, în formatul specific BV7.

  Pentru Log nou - File > New Log... (only 
ADIF import) > Browse -> caută în folde-
rul în care s-a salvat > Save log as: [nume 
log] > Callsign [indicativul dvs] > Start 
Conversion. Programul astfel convertit îl 
găsiţi în Program Files > BV7 > logs de 
unde îl puteţi şterge şi puteţi face o nouă 
încărcare din ADIF.

  Pentru Log existent, parţial prelucrat - File 
> Open log -> şi din fereastra care se des-
chide selectaţi logul de care aveţi nevoie cu 
un click şi > OPEN, logul se va încărca în 
ecran. Următoarea informaţie cu privire la 
fereastra de log se referă la modul cum se 
poate face selecţia QSO-urilor pentru a li 
se putea genera şi tipări etichete QSL. La 
generarea log-ului BV7, QSO-urile sunt 
generate în ordine alfa-numerică a prefixu-
lui (vezi WPX).

  Selecţia în vederea tipăririi (atunci când 
avem deja proiectată eticheta şi numărul 
acestora pe pagină) se poate face pentru 
tipărirea secvenţială a tuturor etichetelor 
prin File > Fill Queue with QSOs of acti-
ve log, când se declanşează o selecţie au-
tomată pentru un număr de QSO-uri egal 
cu numărul etichetelor (deja proiectate) 
existente într-o pagină A4 de autocolante. 
Pot fi selectate mai multe pagini pentru o 

eventuală tipărire, dar este bine să se tipă-
rească pagină cu pagină pentru a nu forţa 
imprimanta deorece paginile autoadezive 
sunt mai groase.

  Selecţia numai anumitor QSO-uri din toată 
lista se poate face în mai multe feluri astfel:

 Deplasarea în listă se face cu CTRL apă-
sat şi săgeată sus sau jos şi imediat un 
CTRL+A pentru fixare.
  Cu click pe triunghiurile negre din bara 
de meniu (dreapta/stânga) urmat de 
CTRL+A pentru fixare.
  În caseta din stânga triunghiurilor se afi-
şează pentru control şi numărul de selec-
ţii efectuate.
  CTRL apăsat şi scroll din lateralul pagi-
nii şi CTRL+A pentru fixare.
  Selecţia unui anumit interval de prefixe 
se face prin scrierea în cele două câmpuri 
libere de sub meniu a acestui interval (ex: 
de la EA6 până la HB9 exclusiv). Se poa-
te face şi numai apelarea primului QSO 
pentru un anumit prefix din panoplia 
WPX (ex: YO sau GW sau LU în primul 
câmp şi Enter) care ne conduce la înce-
putul selecţiei pentru QSO-urile aferente 
acelei entităţi pe care le vom putea tipări 
numai pe ele în mod selectiv. În câmpuri-
le imediat alăturate din dreapta se poate 
face o selecţie rafinată pe benzi şi pe mo-
duri de lucru (CW, SSB sau RTTY).

  Fixarea fiecărei selecţii se face cu 
 CTRL+A. La această comandă se fixează 
toate QSO-urile posibil existente pentru 
acelaşi indicativ care se vor tipări pe ace-
eaşi etichetă.

  Anularea unor selecţii se face cu butonul 
Unselect sau prin apăsarea tastei ESC.

  Deplasarea QSO-urilor în lista de tipă-
rire se face cu un click pe iconul „disk cu 
săgeată galbenă spre stânga“ care are nu-
mele “Put selected QSO(s) into prin queue 
(CTRL+Left)“ sau prin apăsarea simul-
tană CTRL+săgeată stânga. Toate aceste 
operaţiuni se fac după proiectarea ansam-
blului etichetelor în foaia autoadezivă A4, 
deoarece programul face transferul în lista 
de tipărire din stânga ecranului în concor-
danţă cu numărul de etichete generate în 
pagină.
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8. Proiectarea etichetelor

Dacă ne-am familiarizat cu fereastra de log, 
trecem în fereastra de proiectare etichete cu 
Windows > Label Designer Window sau cu 
CTRL+D. Operaţiunea de proiectare etichete 
nu este foarte complicată, dar este relativ la-
bo rioasă pentru cei mai puţin familiarizaţi cu 
ma nevrele pe ecranul calculatorului. La prima 
lansare ni se oferă o foaie goală puţin mai mi că 
decât un A4. În primul rând facem File > Op-
tion şi din fereastra care se deschide cu numele 
“BV Label Designer Option“ selectăm: Units în 
mm, Show design grid, Show component  frames 
şi Line Dotted > OK. În continuare click pe 
Layout din meniu şi apoi pe Layout  Setting, 
care ne aduce o succesiune de ferestre de pa-
rametrizare pentru etichetă. Ignorăm oferta de 
„Custom Type“ şi selectăm „Standard Type“ 
iar din Label Manufacturer alegem o etichetă 
de la un fabricant de etichete. Ţinem minte ce 
am ales şi notăm codul. De fapt aici pro cedura 
este inversă!!!.... fiindcă alegem mai întâi o eti-
chetă existentă în „comerţul de papetărie“ din 
YO ca să ştim mai întâi că o putem procura şi 
apoi trecem la proiectare. Mergeţi în GOOGLE 
şi căutaţi „etichete autoadezive“. Vedeţi ce fur-
nizori locali sau naţionali de papetărie vă oferă 
etichete şi la ce dimensiuni. Veţi găsi şi nume 
total necunoscute dar importante sunt dimensi-
unile. Personal am găsit etichete originale APLI 
(existente şi în listele lui BV7), dar cu aceleaşi 
dimensiuni şi de la alţi furnizori. Di mensiunile 
preferate de mine de la APLI sau alţii au fost 
1272 -> 70x35mm şi 1273 -> 70x37mm. Din ca-
uza imprimantei am pierdut la fiecare coală 3 
etichete din subsol pe care le-am selectat şi le-
am retipărit ulterior. Un exemplu pentru oferte 
de etichete găsiţi la: http://www.officedirect.ro 
sau la http://www.dpap.ro. Alegeţi de fapt orice 
etichetă, funcţie de dorinţă şi preţ, care însă să 
aibă corespondenţă dimensională în BV7 la una 
din firmele din aplicaţie care sunt listate în fe-
reastra Label Manufacturer.

9. Proiectarea textului etichetei 
Pentru început facem pagina exact A4 cum 

va fi la print. Layout > Layout Setting > La-
belType > Standard Type > Label Manu-

facturer > APLI > 3060(210x297) > Next > 
margin toate pe 0 zero > Number of QSL lines 
2 > Finish. În pagina A4 setată astfel în apli-
caţia BV7 facem Layout > Create layout tem-
plate > Confirm > OK şi vi se oferă câmpurile 
standard ale unei etichete de QSL pe care o 
vom concentra în continuare într-o etichetă de 
mici dimensiuni de 70x37 sau 70x35 (sau altă 
dimensiune la alegere). 

Pentru economie de spaţiu tipografic pre-
zentăm în sinteză o procedură de lucru şi ac-
ţiuni. Detalii cu poze de capturi de ecran în 
site-ul autorului http://yo4uq.jimdo.com sau în 
site-ul FRR.

  Cu click se poate selecta orice câmp din 
structură.

  Cu „drag and drop“ se poate selecta şi muta 
cu mouse-ul orice câmp.

  Cu selecţie şi tasta Delete se poate şterge 
orice câmp.

  Din meniu se poate alege fontul şi dimensi-
unea acestuia (recomandăm Arial sau  Arial 
Narrow). Notă: Pentru etichete mici se ale-
ge un font Normal cu dimensiune 8 sau 8 
Bold pentru cuvinte semnificative. Pentru 
HISCALL se poate lua mărimea 11 sau 12 
şi Bold.

  Numărul recomandat de QSO-uri pe eti-
chetă este 2. La mai mult de 2 textul devine 
foarte înghesuit iar la majoritatea celor cu 
o singură legătură iese foarte aerisit.

  Fiecare câmp al unei înregistrări, după se-
lecţie, se poate ajusta ca dimensiuni din 
punctele de selecţie în lungime sau lăţime.

  Orice câmp se poate deplasa stânga-dreap-
ta sau sus-jos cu ajutorul săgeţilor din tasta-
tură ţinând tasta apăsată sau pas cu pas. La 
fel şi după selecţia prealabilă a unui grup 
de câmpuri cu shift şi click-uri.

  Se poate face selecţia multiplă a unui grup 
de câmpuri ţinând apăsată tasta Shift şi fă-
când click succesiv pe câmpuri.

  Mărim aspectul ecranului cu iconul lentilă 
cu + ca să putem lucra mai uşor. Cu - se 
face la loc mic.

  Textul din fiecare câmp se poate alinia 
stânga, dreapta sau central cu icon-urile 
specifice.

  După ce am folosit instrumentele de mai 
sus pentru concentrarea textului etichetei 
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într-un spaţiu cât mai redus din partea de 
stânga sus a paginii A4 revenim la meniul 
Layout şi alegem dimensiunea dorită pentru 
tipărire (de exemplu APLI 1273 (70x37)).

  Layout > Layout Setting > şi aducem la 
zero câmpurile Top, Left, Right şi Bottom 
margin.

  Selectăm Label Type > Standard Type > 
APLI > 1273 (70x37) , moment în care apa-
re aspectul Prewiev al câmpului de etichete 
> NEXT > NEXT > Finish. Proiectul nos-
tru cu toate câmpurile ajustate apare în pri-
ma etichetă din stânga sus a paginii. Dacă 
dorim eventuale ajustări de fonturi, dimen-
siuni de câmpuri sau amplasarea acestora 
le putem face. De fiecare dată este nevoie 
de mici corecţii. Pentru siguranţă facem o 
salvare File > Save as > File name [nume 
fişier] > Save şi proiectul nostru se duce în 
subfolderul layout din BV7.

10. Încercăm o tipărire de probă
  File > Back to Log Window
  File > Load Label Layout > din fereastra 

Open selectăm cu click proiectul salvat an-
terior care se duce în câmpul File name > 
Open

  File > Open Log > selectaţi cu click numele 
logului generat la conversie [nume] > Open

  File > Printer setup > selectaţi imprimanta 
şi verificaţi proprietăţile ei > În Paper să fie 
A4 > OK

  File > Fill Print Queue with QSOs of activ 
log sau apăsaţi tasta F2 > Confirm YES şi 
se afişează în subfereastra din stânga vec-
torul QSO-urilor printabile. La confirmare 
daţi NO pentru a se tipări numai o singură 
pagină.

  Notă: Se va observa că în coloana Qs din 
log indicativele selectate au schimbat starea 
din N în Y. La reluarea tipăririi unei noi pa-
gini acestea vor fi ignorate şi se va selecta în 
continuare o nouă tranşă de 24 de QSO-uri 
care au indicativ N.

  File > Print Label
Se tipăreşte pe o pagină de hârtie de impri-

mantă obişnuită, ca test al proiectului nostru. 
Sigur vor apărea câteva erori minimale de text 
sau poziţionare, dimensiuni de câmp ş.a. În 

special apar la câmpul de HISCALL în cazul 
indicativelor lungi cu alonjă gen QRP sau spe-
ciale cu sufix lung.

Ne întoarcem în BV7 > Windows > Label 
Designer Window şi facem corecţiile necesare 
lungind câmpul sau schimbând fontul şi alinie-
rile. După corecţii facem din nou File > Save 
as pentru o nouă salvare cu acelaşi nume sau 
o nouă variantă V1, V2, V3. După salvare fa-
cem o nouă tipărire de probă, ne întoarcem la 
Log şi Load Label Layout în versiunea nouă. 
Din nou Fill Print sau apăsaţi F2, se selectează 
din nou un calup de 24 de QSO-uri. Dacă con-
sideraţi necesar confirmaţi ştergerea stivei de 
QSO-uri printabile în fereastra „Confirm“ cu 
YES. QSO-urile marcate în câmpul Qs cu Y nu 
se mai pot tipări decât cu reîncărcarea logului 
din formatul iniţial ADIF. Este bine să lucraţi 
în proiectare şi teste cu un log de probă sau cu 
cel al aplicaţiei BV7 numit „sample“ existent 
de la instalarea programului. Dacă aţi terminat 
testările tipăriţi etichetele pagină cu pagină. 

Dacă din logul salvat în format ADIF, din 
aplicaţia dvs de evidenţă log sau de lucru nor-
mal (vezi HRD sau N1MM etc.), conţine şi alte 
câmpuri suplimentare interesante cum ar fi 
numele, locatorul, frecvenţa exactă sau altele, 
unele dintre acestea pot fi „înghesuite“ în eti-
chete. Adăugarea câmpurilor suplimentare se 
face cu Edit > Add new element > Data field 
sau alta din opţiunile oferite şi faceţi după se-
lecţie un click în câmpul etichetei. Expunerea 
detaliată cu figuri explicative şi capturi de ecran 
pentru exemplificarea fiecărui pas se găseş-
te în site-ul autorului http://yo4uq.jimdo.com. 
De asemenea, sunt puse la dispoziţia dvs şi câ-
teva tutoriale cu cele mai importante aspecte 
ale funcţionării aplicaţiei. Succes în proiectare 
iar pentru consultări şi schimburi de experienţă 
între utilizatorii BV7 puteţi deschide un topic 
specializat despre BV7 în forumurile de discu-
ţii ale radioamatorilor YO. Sper ca materialul 
să fie de ajutor şi cei interesaţi să se descur-
ce. Trebuie să mărturisesc că nici eu nu m-am 
descurcat prea bine la primele încercări. Acum 
am o imprimantă ca lumea care scoate toate 
cele 24 de etichete autoadezive dintr-o foaie 
A4 adică un HP Laser Jet P1102.
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Diploma „Bucureşti 555“ 

Cu ocazia împlinirii a 555 de ani de la prima 
menţionare documentară a Bucureştiului se 
conferă diploma „Bucureşti 555“. Pentru ob-
ţinerea ei este necesar ca în perioada 20 sep-
tembrie 2014 - 20 septembrie 2015 să se rea-
lizeze legături radio cu staţii din Municipiul 
Bucureşti.
În această perioadă vor fi active şi indicative 
speciale: YO555BU, YP555BU, YQ555BU şi 
YR555BU.

Fiecare legătură radio conferă câte un punct/
banda şi/sau mod de lucru (CW, PH, RTTY, 
PSK, alte DG - o singură categorie: JT65, 
ROS, Olivia, Hell etc.).
Se poate lucra în orice bandă autorizată. Nu 
sunt valabile legăturile prin repetoare fără sau 
cu acces echolink.

Legăturile realizate în perioada concursului 
Bucureşti 2015 se cotează cu 2 puncte.

Diploma se eliberează în patru clase:
  Clasa „Novice“ - este necesar un total de 
50 puncte;

  Clasa „Standard“ - este necesar un total 
de 100 puncte;

  Clasa „Avansat“ - este necesar un total 
de 250 puncte;

  Clasa „Extra“ - este necesar un total de 
500 puncte.

Cererile se trimit până cel târziu 01.12 2015. 
Staţia care la sfârşitul perioadei va avea punc-

tajul cel mai mare va primi un trofeu special.
Diplomele se eliberează gratuit în format elec-
tronic. 
În cazul în care se doreşte tiparită, se va achita 
suma de 5 lei, pentru staţiile YO. Cererile se 
vor trimite la  yo555bu@hamradio.ro.
Staţiile din Bucureşti care vor realiza QSO în 
această perioadă şi doresc să primească o di-
plomă sunt rugate să trimita logurile în format 
ADIF la frr@hamradio.ro.

Diploma „Alfabet“
Această diplomă se eliberează pentru legături 
cu staţii care în indicativ au literele alfabetu-
lui latin A-Z (26 caractere). Pentru a se valida 
este necesar ca poziţia literei să fie în acelaşi 
loc. Astfel, după cifră, să fie ori prima, ori a 
doua, ori a treia. 
Cererea se trimite la frr@hamradio.ro.
Diploma se eliberează gratuit în format elec-
tronic. În cazul în care se doreşte tipărită, pen-
tru staţiile YO se va achita suma de 5 lei. 
Aceste diplome se eliberează şi pentru recep-
tori.
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Telegrafia reprezintă modul de transmite-
re a informaţiilor prin impulsuri nemodulate, 
folosind un anume cod. Cel mai cunoscut cod 
este cel propus de pictorul Samuel Finley Bree-
se Morse (1791-1872), în anul 1838, cod cunos-
cut în România sub denumirea de Alfabetul 
 Morse. Şase ani mai târziu, în 1844, cu sprijinul 
inginerului Alfred Vail (1807-1859), realizează 
primul telegraf cu care realizează prima legă-
tură telegrafică între Washington şi Baltimore. 
Sistemul a fost rapid adoptat de serviciile poşta-
le şi de căi ferate din SUA.

În perioada de început a telecomunicaţiilor 
fără fir, telegrafia Morse a fost intens folosită. 
Pe măsură ce alte moduri de comunicare au 
fost dezvoltate, telegrafia a pierdut teren din 
cauza ratei scăzute a informaţiilor transmise, 
dar şi din cauza faptului că necesita o pregătire 
specială a operatorilor.

În prezent, serviciile comerciale au renunţat 
la telegrafia Morse. Singurii care o mai folosesc 
sunt radioamatorii. Radioamatorii au folosit 
telegrafia ca un mod de întrecere, mai întâi în 
competiţii de unde scurte, apoi şi de unde ul-
trascurte, culminând cu întrecerile faţă-în-faţă 
la competiţii de telegrafie sală, denumite ulte-
rior de telegrafie viteză. 

Performanţa internaţională la telegrafie înce-
pe cu anul 1983, când fosta URSS organizează 
primul Campionat European şi unde România 
(RSR pe atunci) ocupă locul II după URSS, dar 
înaintea Cehoslovaciei. La individual s-a obţinut 
medalie de aur la junioare prin Ailincăi Manuela 
şi 3 medalii de argint prin Manea Janeta. Din lot 
au mai făcut parte Adi Udrescu, Marian Potera-
şu şi Geo Câmpeanu, având antrenor pe Vasile 
Căpraru. La următoarea ediţie de la Hanovra – 
RFG din 1989, echipa României a lipsit.

Ediţia a III-a a Campionatelor Europene de 
telegrafie viteză de la Neerpelt Belgia 1991 a 
fost onorată şi cu participarea unei echipe a 

României, formată din Dabija Gabriela, Ivan 
Gabriela şi Manea Janeta la feminin, şi Potera-
şu Marian, Ispas Horia, Peteu Iulian, Hâldan 
Cristian, Covrig Cristinel şi Căpraru Vasile la 
masculin, conduşi de Drăgulescu Gheorghe, 
obţinând locul III la echipe şi 3 medalii de 
bronz la individual.

Din anul 1995, IARU organizează Campio-
natele mondiale din 2 în 2 ani, începând cu Sio-
fok – Ungaria în 1995, Sofia – Bulgaria în 1997, 
Pordenone – Italia 1999, Constanţa – România 
în 2001 şi continuând în anii impari cu Minsk 
– Belarus 2003, Ohrid – Macedonia 2005, Bel-
grad – Serbia 2007,  Obzor – Bulgaria 2009, Bie-
lefeld – Germania şi Borovets – Bulgaria 2013.

Din anul 2004 se reiau Campionatele Euro-
pene cu ediţia a 4-a la Nis – Serbia, apoi Pri-
morsko – Bulgaria 2006, Pordenone – Italia  
2008, Skierniewice – Polonia 2010, Beatem-
berg – Elveţia 2012 şi Bar – Muntenegru 2014. 

În 2013 iau fiinţă Campionatele Balcanice, 
pri ma ediţie fiind la Lovech – Bulgaria, iar 
a doua ediţie la Piatra-Neamţ – România în 
2014, am bele ediţii fiind câştigate de echipa 
României.

Cel mai bun rezultat al României la Campi-
onatele Mondiale a fost în 2005 în Macedonia, 
locul II la echipe (singura dată când România 
întrece Rusia) şi obţinerea primului record 
mondial prin Buzoianu Bogdan la proba prac-
tică recepţia indicativelor RUFZ, iar cea mai 
bună participare la Campionatele Europene 
a fost în 2014, când România a obţinut 31 de 
medalii la individual, din care 6 medalii de aur.

Antrenorii loturilor naţionale de telegrafie 
viteză au fost:

• Căpraru Vasile, între anii 1983 şi 1991
• Bratu Radu, între anii 1992 şi 2002
• Paisa Gheorghe, între anii 2002 şi 2010
• Zaiţ Adrian, între anii 2011 şi 2012
• Paisa Gheorghe, din 2013 

TELEGRAFIA – DE LA 
PASIUNE LA PERFORMANŢĂ

Antrenor emerit Gheorghe Paisa
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De remarcat că FRR a avut de la înfiinţare 
în grupul de lucru la IARU – telegrafie viteză 
pe Craiu George 1980-1989, Drăgulescu Ghe-
orghe 1989-2003 şi Paisa Gheorghe 2003 până 
în prezent, practic fiind permanenţi în forul 
decizional. De asemenea, FRR a avut arbitri 
din România la toate competiţiile internaţio-
nale prin Craiu George, Bratu Radu, Drăgu-
lescu Gheorghe, Paisa Gheorghe, Nicolaescu 
Sorin şi o tentativă eşuată cu Hâldan Cristian.

Înscrierea României în istoria performanţei 
internaţionale a fost posibilă prin munca mul-

tor radioamatori inimoşi, care s-au dăruit pen-
tru pregătirea performerilor, prin multe ore de 
antrenamente, dar şi prin eforturi financiare 
deosebite.  Radiocluburi din Bucureşti, Sucea-
va, Bacău, Ploieşti, Constanţa, Iaşi, Galaţi, Bu-
zău, Piatra-Neamţ, Giurgiu, Pucioasa au dat 
pentru istoria telegrafiei româneşti performeri 
care au menţinut tricolorul românesc perma-
nent pe podiumurile de premiere. Efortul lor 
va rămâne un exemplu pentru generaţiile vi-
itoare şi o motivare pentru rezultate cât mai 
deosebite în viitor. 

Nr. Competiţia
Loc echipa 
naţională a 
României

Medalii 
de aur

Medalii 
de 

argint

 Medalii 
de bronz Record mondial Antrenor

1. Campionatele mondiale de telegrafie 
viteză Siofok – Ungaria 1995 III 1 1 1 Bratu Radu

2. Campionatele mondiale de telegrafie 
viteză Sofia – Bulgaria 1997 III 1 1 Bratu Radu

3. Campionatele mondiale de telegrafie 
viteză Pordenone – Italia 1999 III 1 1 Bratu Radu

4. Campionatele mondiale de telegrafie 
viteză Constanţa – România 2001 III 1 Bratu Radu

5. Campionatele mondiale de telegrafie 
viteză Minsk – Belarus 2003 III 1 6 7 Paisa Gheorghe

6. Campionatele mondiale de telegrafie 
viteză Ohrid – Macedonia 2005 II 3 6 11

Buzoianu Emil 
Bogdan – proba 
practică RUFZ

Paisa Gheorghe

7. Campionatele mondiale de telegrafie 
viteză Belgrad – Serbia 2007 III 3 8 15

Buzoianu Emil 
Bogdan – proba 
practică RUFZ

Paisa Gheorghe

8. Campionatele mondiale de telegrafie 
viteză  Obzor – Bulgaria 2009 III 3 5 17 Paisa Gheorghe

9. Campionatele mondiale de telegrafie 
viteză  Bielefeld – Germania 2011 III 2 7 12 Paisa Gheorghe 

10. Campionatele mondiale de telegrafie 
viteză Beatenberg – Elveţia  2012 III 1 7 15 Zaiţ Adrian

11. Campionatele mondiale de telegrafie 
viteză Borovets – Bulgaria 2013 III 3 7 15 Zaiţ Adrian

12. Campionatele Europene de telegrafie 
viteză Moscova – URSS 1983 II 1 3

3 recorduri europene 
la recepţie şi 

transmitere obţinute 
de Manea Janeta

Căpraru Vasile

13. Campionatele Europene de telegrafie 
viteză Neerpelt – Belgia 1991 III 3 Căpraru Vasile

14. Campionatele europene de telegrafie 
viteză Nis – Serbia 2004 III 1 8 9 Paisa Gheorghe

15. Campionatele europene de telegrafie 
viteză Primorsko – Bulgaria 2006 III 3 4 12

Buzoianu Emil 
Bogdan – proba 
practică RUFZ

Paisa Gheorghe

16. Campionatele europene de telegrafie 
viteză Pordenone – Italia 2008 III 2 6 8 Paisa Gheorghe

17. Campionatele europene de telegrafie 
viteză Skiernewice – Polonia 2010 III 3 7 17 Paisa Gheorghe

18. Campionatele europene de telegrafie 
viteză Bar – Muntenegru 2014 III 6 5 20 Paisa Gheorghe

19. Cupa Europei telegrafie viteză 
Skiernewicw – Polonia 2009 III

Buzoianu Emil 
Bogdan – proba 
practică RUFZ

Paisa Gheorghe

20. Cupa Europei telegrafie viteză
Suceava – România 2010 III

Buzoianu Emil 
Bogdan  – proba 
practică Morse 

Runner

Paisa Gheorghe

21. Cupa Europei telegrafie viteză
Skiernewicw – Polonia 2014 III Paisa Gheorghe

22. Campionatul Balcanic I 6 2 2 Paisa Gheorghe
23. Campionatul Balcanic I 8 1 5 Paisa Gheorghe

Rezultatele detaliate în istoria performanţei internaţionale sunt prezentate în tabelul următor:
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Descrierea Microfonului APRS

Microfonul APRS are rolul de a funcţiona ca 
un microfon extern cu difuzor, având în plus po-
sibilitatea de a transmite poziţia acestuia la in-
tervale prestabilite şi sincronizate.

Acesta este compus dintr-un microprocesor 
AVR Atmega64a, modul GPS cu antenă încor-
porată Maestro A2235H, regulator de tensiune 
specializat MCP1253-33X50, potenţiometru di-
gital de 10k şi un circuit integrat de încărcare a 
acumulatorului LiIon MCP73811T.

Transmiterea poziţiei se face printr-un pachet 
APRS care se transmite automat la un interval 
prestabilit (ex. – odată la 30 de secunde înce-
pând cu secunda 14 a fiecărui minut, rezultând 
2 pachete pe minut la secunda 14 şi secunda 44).

Deoarece ceasul furnizat de GPS este foarte 
precis, se pot configura mai multe microfoane 
APRS să transmită poziţia fiecăruia într-o for-
mă sincronizată, fără a transmite două în acelaşi 
timp.

Microprocesorul Atmega64a are un consum 
de 8mA în modul de lucru activ, şi 1mA în mo-
dul de lucru sleep (stare oprită).

Modulul GPS Maestro A2235H are un con-
sum de 44mA la căutarea sateliţilor GPS, iar 
când a determinat o poziţie fixă consumul este 
redus la 22mA, în modul oprit consumă doar 
0.03mA.

Microfonul APRS are în total un consum de 
30mA în starea activă, acumulatorul LiIon de 
1000mAh ajungând aproximativ pentru 28 de 
ore de funcţionare continuă, în starea oprit con-
sumul total fiind de 2mA.

Conexiunea dintre microfon şi staţie se face 
printr-un cablu cu 4 fire şi o mufă mini cu 6 pini, 
astfel conectând un adaptor se poate conecta la 
orice staţiă radio.

Descrierea utilizării
Microfonul APRS trebuie pornit ţinând apă-

sat butonul lateral care are şi funcţia de PTT 
până când ledul verde clipeşte. Lăsând liber 
acest buton, intrarea în funcţionarea normală 
este anunţată de clipirea scurtă a ledului roşu.

În scurt timp, ledul verde clipeşte de 2 ori pe 
secundă prin care microfonul ne confirmă por-
nirea modulului GPS şi faptul că se caută poziţie 
fixă.

Când modulul GPS ne transmite o poziţie 

fixă, microfonul APRS ne anunţă acest lucru 
prin clipirea ledului verde la un interval de apro-
ximativ o secundă.

În tot acest timp, se poate apăsa butonul PTT 
şi folosi staţia exact ca un microfon extern nor-
mal, starea de intrare în emisie este anunţată de 
aprinderea ledului roşu continuu până la termi-
narea convorbirii, lăsarea liberă a PTT-ului.

Microfonul APRS se poate opri ţinând apă-
sat butonul special din partea dreaptă jos, ledul 
roşu clipeşte intermitent şi butonul trebuie ţinut 
apăsat până nu va mai clipi, indicând intrarea în 
starea de oprire.

A1 – Modulul GPS
Modulul GPS furnizează date despre ora, 

poziţia, viteza, altitudinea curentă în formatul 
NMEA şi le trimite către procesorul AVR, care 
va extrage aceste informaţii şi va crea un pachet 
în format APRS.

Comunicaţia serială (UART) între modul şi 
procesor se face la viteza 9600 baud, la intervalul 
de o secundă.

Pentru a controla modulul GPS, procesorul 
are următoarele conexiuni:

 GPS_RESET – are funcţia de a reseta modu-
lul
 GPS_WAKEUP – este folosit pentru a trece 
modulul din starea de consum minim (sleep) 
în starea de funcţionare normală
 GPS_ONOFF – cu ajutorul acestui semnal se 
porneşte/opreşte modulul
 GPS_RX – pinul de recepţie a interfeţei 
UART
 GPS_TX – pinul de transmisie a interfeţei 
UART

 
A2 – Controlul PTT al staţiei radio

Controlul de intrare a staţiei în emisie se face 
cu ajutorul unui tranzistor npn al cărui colector 
este legat la firul PTT al staţiei (TRX_PTT) şi 
microprocesorul îl controlează prin semnalul 
C_PTT.
 
A3 – Generator audio

Producerea tonurilor de 1200 şi 2200 Hz fo-
losite în modulaţia AFSK pentru a transmite 
pachetele APRS se generează cu ajutorul unui 
convertor DAC, iar amplitudinea acestuia este 
controlată de un potentiometru digital de 10k.

Microfon APRS
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Potenţiometrul digital este controlat de mi-
croprocesor prin magistrala SPI şi ajută la alege-
rea corectă a amplitudinii semnalului audio care 
va fi transmis către staţia radio. Această valoare 
va putea fi setată cu ajutorul calculatorului.
 
A4 – Microfonul audio

Semnalul audio de la microfon este conectat 
la intrarea audio a staţiei radio şi este controlat 
de microprocesor prin semnalul C_MIC cu aju-
torul unui tranzistor npn al cărui colector este 
legat la semnalul AUDIO_OUT.

Controlul microfonului este necesar pentru a 
nu introduce zgomot când se transmite pachetul 
APRS, fiind legat la masă doar când nu se trans-
mit pachete APRS.
 
A5 – Încărcător LiIon

Încărcarea acumulatorului LiIon se face cu 
circuitul integrat specializat MCP73811T la un 
curent maxim de aproximativ 500mA, tensiunea 
de intrare folosită fiind de 5V.

Încărcarea acumulatorului LiIon se face au-

tomat şi se opreşte automat în momentul când 
este încărcat. Microprocesorul citeşte tensiunea 
acumulatorului şi determină starea de încărcare 
a acestuia.

Starea de încărcare este anunţată prin clipi-
rea ledului rosu, iar încărcarea completă se face 
prin aprinderea ledului verde continuu.
 
A6 – Acumulatorul LiIon

Microfonul APRS foloseşte un acumulator 
LiIon de 3.7V 1000mAh deoarece majoritatea 
staţiilor radio nu oferă o sursă de alimentare su-
ficientă, în majoritatea cazurilor fiind inexistentă.

Acest acumulator are în serie o siguranţă de 
1A pentru protecţie în caz de scurtcircuit.

Valoarea mare a acestuia oferă o utilizare în-
delungată a microfonului APRS. S-a ales acest 
tip de acumulator deoarece este mai uşor ca alţi 
acumulatori gen NiMh, este ieftin şi uşor de găsit.
 
A7 – PTT şi configurarea

Microfonul APRS este prevăzut cu un buton 
lateral care are rolul de PTT şi când este apăsat 

YO5CAY Budurache Marcel
LOCUL 2  - CAMPIONATUL NAŢIONAL DE CREAŢIE TEHNICĂ 2014
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staţia radio trece pe emisie şi microfonul audio 
este conectat corespunzător pe intrarea audio a 
staţiei.

Conectarea microfonului audio se face doar 
după transmiterea pachetului APRS dacă este 
cazul. Dacă este momentul de a transmite pa-
chetul APRS dar microfonul este folosit, pache-
tul va fi transmis la sfârşitul emisiei.

Configurarea microfonului APRS se face cu 
ajutorul PC-ului prin interfaţa UART a micro-
procesorului (PC-ul se conectează folosind un 
convertor RS232 - UART 3.3V half duplex). 
Pinii microprocesorului RxD şi TxD corespund 
interfeţei UART1.

Butonul PTT al acestui microfon mai are şi 
funcţia de pornire dacă microfonul APRS este 
oprit. Se ţine apăsat până ledul clipeşte şi are 
culoarea verde, anunţând să lăsăm liber butonul. 
Pornirea acestuia este anunţată de clipirea scur-
tă a ledului de culoare roşie.

Microfonul APRS porneşte modulul GPS, iar 
primirea datelor este confirmată prin clipirea le-
dului verde de aproximativ 2 ori pe secundă.

 A8 – Conexiunea GPS
Procesorul se conectează la modulul GPS 

prin interfaţa UART cu ajutorul semnalelor 
GPS_RX şi GPS_TX astfel:

 TxD la GPS_RX
 RxD la GPX_TX

Pinii microprocesorului TxD şi RxD cores-
pund interfeţei UART0.

Această conexiune are rolul de a prelua da-
tele de la modulul GPS de către microprocesor 
pentru a putea fi prelucrate.
 
A9 – Regulator tensiune 3,3V

Acumulatorul LiIon de 3.7V oferă o tensiu-
ne variabilă între 4.2V (când e încărcat) şi 3.3V 
(când e descărcat).

Se foloseşte un regulator de tensiune de 3.3V 
pentru a avea o tensiune stabilă şi un semnal au-
dio generat stabil (amplitudinea lui să nu aibă 
variaţii mari).

Circuitul integrat specializat MCP1253-33x50 
stabilizează tensiunea la 3.3V cu pierderi foarte 
mici, şi un curent maxim de 120mA. Acesta con-
sumând doar 80μA când nu are consumatori.
 
A10 – Controlul încărcării

Existând doar 4 fire de ieşire – PTT, Audio 
Out, Audio In şi GND –, acestea sunt folosite şi 
pentru a fi conectate la încărcătorul extern.

Se foloseşte firul AUDIO_OUT pentru a ali-
menta microfonul APRS cu o tensiune de 5V, 
prezenţa încărcătorului se face prin transmite-
rea unui ID cu ajutorul firului PTT fiind folosit 
pentru comunicarea half duplex UART.
 

A11 – Monitorizarea acumulatorului
Monitorizarea acumulatorului LiIon se face 

cu ajutorul convertorului ADC al procesorului. 
Când tensiunea sa ajunge aproape de valoarea 
de 3.3V, procesorul opreşte modulul GPS şi in-
tră în starea de consum minim, ledul fiind stins 
permanent.

După conectarea la încărcătorul extern, pro-
cesorul rămâne în starea de consum minim până 
la încărcarea completă a acumulatorului şi deco-
nectarea încărcătorului.
 
A12 – Programarea procesorului

Programarea iniţială a procesorului cu 
 firmware-ul se face prin conectorul JTAG. Ul-
terior procesorul poate fi încărcat cu un cod nou 
cu ajutorul interfeţei half duplex UART de către 
PC, cu acelaşi convertor RS232- UART 3.3V fo-
losit la configurarea microfonului APRS.
 
A13 – Componentele microprocesorului

Componentele microprocesorului conţin 
componente folosite pentru funcţionarea lui. 
Acestea sunt: ceasul procesorului (foloseşte un 
quartz pentru o stabilitate mărită a frecvenţei de 
lucru), componentele pentru buna funcţionare a 
convertorului ADC pentru măsurarea tensiunii 
acumulatorului LiIon, alimentare cu tensiunea 
de 3.3V şi masa la diferiţi pini.
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Competiţii organizate de FRR
   Campionatele Naţionale de Unde 
Scurte 3,5MHz 

   radiotelegrafie (CW): 2 şi 9 
martie

   radiotelefonie (SSB): 5 şi 12 
octombrie

   Campionatul Naţional Multiband de 
US – YO DX HF: 29-30 august

   Campionatele Naţionale de Unde 
Ultrascurte

   144 MHz CW, SSB, FM (YO-
FIF): 15 august

   432 MHz CW, SSB, FM (YO-
UIF 432 MHz): 16 august

   1296 MHz CW, SSB, FM (YO-
UIF 1296 MHz): 16 august

   Campionatele Internaţionale de UUS 
ale României YO-VHF/UHF – 144, 
432, 1296 MHz CW, SSB, 
FM 4-5 iulie

 Campionatul Naţional de Tineret 
ARDF 144 Mhz –  23 mai, Zalău, SJ

 Campionatul Naţional de tineret 
ARDF 3,5 MHz – 24 mai, Zalău, SJ

 Campionatul Naţional Echipe ARDF 
144 MHz – 27 iunie, Tg.-Mureş, MS

 Campionatul Naţional Ştafetă ARDF 
– 28 iunie, Tg.-Mureş, MS

 Campionatul Naţional Echipe ARDF 
3,5 MHz – 28 iunie, Tg.-Mureş, MS

 Campionatul Naţional individual 
ARDF 144 Mhz – 7 august, Iaşi, IS

 Campionatul Naţional individual 
Sprint ARDF – 10 august, Iaşi, IS

 Campionatul Naţional Foxoring 
ARDF – 8 august, Iaşi, IS

 Campionatul Naţional individual 3,5 
MHz ARDF – 9 august, Iaşi, IS

   Campionatele Naţionale de Tele-
grafie Viteză (recepţie, transmitere, 
RUFZ/PED pentru Veterani, Seni-
ori, Juniori Mari, Juniori mici): 4-6 
aprilie Piatra-Neamţ

 Campionatul Naţional de Creaţie 
Tehnică şi Simpozionul Naţional YO 
– Bucureşti 21-23 august Cluj-Napoca

   Campionatul Naţional de Telegrafie 
Viteză (recepţie, transmitere, RUFZ/
PED – Echipe) – 10-13 septembrie 
Piatra-Neamţ

 Campionatul Naţional RTTY 7-14 
septembrie

Competiţii organizate în 
colaborare cu Asociaţii Judeţene 
sau Cluburi Sportive afiliate

 Concursul „LA MULŢI ANI YO!“ – 
3,5 MHz SSB (FRR) 2 ianuarie

 Cupa Municipiului Câmpina (YO-
9KPB) 3,5 MHz, CW/SSB: 5 ianuarie

 Memorial YO2RA – 19 ianuarie

 Cupa CARAŞULUI (YO2KCB) 3,5 
MHz CW şi SSB: 2 februarie

 Concursul „Maratonul Ion Creangă“: 
9-22 februarie

 Memorial YO9WL (YO9KPB): 9 
februarie

 Cupa Moldovei (YO8KAN) 3,5 MHz 
CW şi SSB: 16 februarie

   Concursurile MEMORIAL Dr. 
SAVOPOL (YO7KAJ) 1,8 MHz CW 
şi SSB: 6 martie 3,5 MHz RTTY – 6 
martie

 Cupa Mărţişorului (YO5KUF): 8 
martie

 Concursul BUCUREŞTI (YO3JW) 
3,5MHz CW SSB – 16 martie 

 Concursul „Ziua Jandarmeriei 
Române“ (AS Delta Jandarmi 
Tulcea) 3,5 MHz SSB : 23 martie

 Cupa OTCR US 3,5 MHz CW/SSB 
(YO2BV): 5 aprilie

 Concursul TROFEUL CARPAŢI 
(AJR Braşov) 3,5 MHz CW şi SSB: 
6 aprilie

 Concursul CUPA ELEVILOR 3,5 
MHz (YO2KJI): 13 aprilie

 Cupa Târgovişte ARDF – 27-29 mar-
tie, Târgovişte, DB

   Cupa DECEBAL ARDF – Concurs 
Internaţional de Radio-orientare 
(YO2KAR): 30.04-03.05, Deva, HD

 Cupa NAPOCA (YO5KIP) UUS 
CW, SSB 144, 432 şi 1296 MHz: 
2-3 mai

 Cupa „CONSTANTIN BRÂNCUŞI“ 
– ARDF 3,5 MHz YO7KFX Tg.-Jiu: 
15-17 mai, Tg.-Jiu, GJ

 Cupa „Lucian Blaga“ 3,5 MHz SSB 
(YO5KLB): 4 mai

 Cupa INDEPENDENŢEI (CSR 
Istriţa) 3,5 MHz CW şi SSB: 
27 aprilie

 Ziua Telecomunicaţiilor – US 3,5 
MHz (YO HD Antena DX Grup) 
CW/SSB 11 mai

 Ziua Telecomunicaţiilor – UUS (YO 
HD Antena DX Grup) CW/SSB 
6-8-10 UTC 144 şi 432 MHz: 17 mai

 Cupa BRĂILEI (YO4KAK) 
3,5 MHz: 18 mai

   Concursul Internaţional „CUPA 
BUCOVINEI“ ARDF (Palatul 
Copiilor Câmpulung-Moldovenesc,
CSTA SV): 29-31 mai

 Cupa Municipiului Piteşti US CW/
SSB, (YO7KFA): 25 mai

 Concursul FLOAREA DE MINĂ 
(YO5KAD) 144, 432 şi 1296 MHz: 
6-7 iunie

 Cupa TELEORMAN (YO9KPM) 
3,5 MHz CW şi SSB: 1 iunie

 Concursul Internaţional Cupa Silver 

Fox – UUS (YO2KAR) – 13-14 iunie

 Cupa EMINESCU 7 MHz 
(YO8KOB): 14 iunie

 Concurs „Memorial YO7VS“ (YO 
HD Antena DX Grup) în paralel cu 
IARU 50 MHz: 13-14 iunie

   Cupa CONSTRUCTORUL DE 
MAŞINI (YO5KAS) 144 MHz, 432 
MHz şi 1296 MHz CW, SSB, FM:
20-21 iunie

 Cupa Valea Caraşului ARDF, 
Oraviţa: 24-26 iulie

 Cupa TRANSMISIONISTULUI 
(YO2CJX) 3,5 MHz CW şi SSB: 
13 iulie

 Summer VHF/UHF/DX Contest 
(YO2KBK): 18-19 iulie

 Cupa Moldovei UHF/VHF 
(YO8KGP) 18-19 iulie

   Concursul „Memorial YO7VS“ 144 
MHz (YO2KQY YO HD DX) CW, 
SSB, FM: 5-6 septembrie

 Cupa Pompierilor US: 11 septembrie 
AS Delta Jandarmi Tulcea

 Cupa George Enescu (YO8KGL) 
3,5 MHz: 7 septembrie

 Cupa Castrum Zotmar radio 
orientare Satu-Mare: 2-4 octombrie 

 Cupa Bucegi, ARDF 18-20 septem-
brie, Târgovişte, DB

   Cupa „Silver Fox“ ARDF 
(YO2KAR), Gala Campionilor 
Radio orientare Târgovişte 
Deva 4-6 septembrie

 Cupa „25 OCTOMBRIE“ 
(YO2CJX) 3,5 MHz: 19 octombrie

 Cupa Feroviarului 3,5 MHz CW-SSB 
(YO5KUF): 7 noiembrie

 Concursul MEMORIAL YO (FRR) 
3,5 MHz SSB: 2 noiembrie

 Maraton POSADA 1330: 3-13 no-
iembrie (Radioclubul COZIA)

 Concursul YO PSK 31 US 
(YO5CRQ, YO5KAD): 
20 noiembrie

 Cupa „Galaţi“ (YO4KBJ): 
28 noiembrie

 Cupa „1 DECEMBRIE“ US – 3,5 
MHz (YO5KTO şi FRR): 
1 decembrie

 Concursul „TOPS“ (Pro CW Club) 
US CW: 5-6 decembrie

 Cupa „Ceahlăul“ – Telegrafie viteză 
(YO8KGP): 27-29 noiembrie 
Piatra-Neamţ

 Cupa „Silver Fox“ US 3,5 MHz: 
14 decembrie

 Cupa Timişului – 3,5 MHz QSO 
Banat Timişoara (YO2KQT): 20 
decembrie

 Cupa Minorităţilor US 3,5 & 7 MHz 
(CSR Brăila): 12 decembrie

CALENDAR COMPETIŢIONAL NAŢIONAL - 2015
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CALENDAR COMPETIŢIONAL 
INTERNAŢIONAL

IANUARIE - MARTIE 2015
Data 
start

UTC start Date end
UTC 
end

CONTEST Mode

1/01/2015 08:00 1/01/2015 11:00 SARTG New Year Contest RTTY

1/01/2015 09:00 1/01/2015 12:00 AGCW Happy New Year Contest CW

3/01/2015 12:00 4/01/2015 12:00 WW PMC Contest CW/SSB

3/01/2015 18:00 3/01/2015 23:59 ARRL RTTY Roundup DIGI

3/01/2015 20:00 3/01/2015 23:00 ON5ME - EU CW 160 Meter Contest - 1 CW

4/01/2015 00:00 4/01/2015 23:59 VERON SWL’s New Year Contest SWL

4/01/2015 04:00 4/01/2015 07:00 ON5ME - EU CW 160 Meter Contest - 2 CW

4/01/2015 09:30 4/01/2015 10:30 EU QRP Foxhunt CW/PSK/SSB

5/01/2015 19:30 5/01/2015 20:30 EU QRP Foxhunt CW/PSK/SSB

10/01/2015 12:00 11/01/2015 12:00 UBA PSK63 Prefix Contest BPSK63

10/01/2015 18:00 11/01/2015 05:59 North American QSO Party CW

11/01/2015 09:00 11/01/2015 10:59 DARC 10 meter Contest CW/SSB

11/01/2015 09:30 11/01/2015 10:30 EU QRP Foxhunt CW/PSK/SSB

12/01/2015 19:30 12/01/2015 20:30 EU QRP Foxhunt CW/PSK/SSB

17/01/2015 00:00 17/01/2015 04:00 LZ Open Contest 80/40m CW

17/01/2015 12:00 18/01/2015 11:59 Hungarian DX Contest CW/SSB

17/01/2015 18:00 18/01/2015 05:59 North American QSO Party SSB

18/01/2015 09:30 18/01/2015 10:30 EU QRP Foxhunt CW/PSK/SSB

19/01/2015 19:30 19/01/2015 20:30 EU QRP Foxhunt CW/PSK/SSB

23/01/2015 22:00 25/01/2015 22:00 CQ WW 160-Meter Contest CW

24/01/2015 06:00 25/01/2015 18:00 REF Contest CW

24/01/2015 12:00 25/01/2015 12:00 BARTG RTTY Sprint Contest RTTY

25/01/2015 09:30 25/01/2015 10:30 EU QRP Foxhunt CW/PSK/SSB

26/01/2015 19:30 26/01/2015 20:30 EU QRP Foxhunt CW/PSK/SSB

31/01/2015 00:00 1/02/2015 23:59 VERON SLP Contest - Part 1 SWL

31/01/2015 13:00 1/02/2015 13:00 UBA DX Contest SSB

1/02/2015 09:30 1/02/2015 10:30 EU QRP Foxhunt CW/PSK/SSB

2/02/2015 19:30 2/02/2015 20:30 EU QRP Foxhunt CW/PSK/SSB

7/02/2015 00:00 7/02/2015 23:59 TRIATHLON RTTY-SSB-CW CONTEST RTTY-SSB-CW

7/02/2015 00:00 8/02/2015 23:59 Vermont QSO Party CW/SSB/Digital

7/02/2015 00:01 8/02/2015 23:59 10-10 Winter Phone SSB

7/02/2015 12:00 8/02/2015 11:59 Black Sea Cup International CW/SSB

7/02/2015 14:00 7/02/2015 23:59 Minnesota QSO Party CW/SSB/Digital

7/02/2015 16:00 7/02/2015 19:00 AGCW Straight Key Party 80m CW

7/02/2015 17:00 8/02/2015 01:00 Delaware QSO Party CW/Phone

7/02/2015 18:00 8/02/2015 17:59 Mexico International RTTY Contest RTTY

8/02/2015 00:00 8/02/2015 04:00 North America Sprint Contest CW

8/02/2015 09:30 8/02/2015 10:30 EU QRP Foxhunt CW/PSK/SSB
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9/02/2015 13:00 13/02/2015 23:59 ARRL School Club Roundup CW/SSB

9/02/2015 19:30 9/02/2015 20:30 EU QRP Foxhunt CW/PSK/SSB

14/02/2015 00:00 15/02/2015 23:59 CQ World-Wide RTTY WPX Contest RTTY

14/02/2015 11:00 14/02/2015 13:00 Asia-Pacific Sprint CW

14/02/2015 12:00 15/02/2015 12:00 Dutch PACC Contest CW/SSB

14/02/2015 17:00 14/02/2015 21:00 FISTS Winter Sprint CW

14/02/2015 21:00 15/02/2015 01:00 RSGB1,8 MHz Contest CW

15/02/2015 09:30 15/02/2015 10:30 EU QRP Foxhunt CW/PSK/SSB

16/02/2015 19:30 16/02/2015 20:30 EU QRP Foxhunt CW/PSK/SSB

18/02/2015 19:00 18/02/2015 20:30 AGCW Semi Automatic Key Evening CW

20/02/2015 21:00 21/02/2015 21:00 Russian WW PSK Contest BPSK31, 63, 125

21/02/2015 00:00 22/02/2015 23:59 ARRL International DX Contest CW

22/02/2015 09:00 22/02/2015 11:00 High Speed Club CW Contest - 1 CW

22/02/2015 09:30 22/02/2015 10:30 EU QRP Foxhunt CW/PSK/SSB

22/02/2015 15:00 22/02/2015 17:00 High Speed Club CW Contest - 2 CW

23/02/2015 19:30 23/02/2015 20:30 EU QRP Foxhunt CW/PSK/SSB

27/02/2015 22:00 1/03/2015 22:00 CQ WW 160-Meter Contest SSB

28/02/2015 06:00 1/03/2015 18:00 REF Contest SSB

28/02/2015 13:00 1/03/2015 13:00 UBA DX Contest CW

28/02/2015 18:00 1/03/2015 05:59 North American QSO Party RTTY

1/03/2015 07:00 1/03/2015 11:00 UBA Spring Contest 80m CW

7/03/2015 00:00 8/03/2015 23:59 ARRL International DX Contest SSB

7/03/2015 00:00 8/03/2015 23:59 VERON SLP Contest - Part 2 SWL

7/03/2015 19:00 7/03/2015 21:00 AGCW YL CW Party CW

7/03/2015 20:00 7/03/2015 21:59 Open Ukraine RTTY Championship - Low Band - 1 RTTY

7/03/2015 22:00 7/03/2015 23:59 Open Ukraine RTTY Championship - Low Band - 2 RTTY

8/03/2015 07:00 8/03/2015 11:00 UBA Spring Contest 6M CW/Phone

8/03/2015 08:00 8/03/2015 11:59 Open Ukraine RTTY Championship - High Band RTTY

8/03/2015 11:00 8/03/2015 17:00 DARC 10-Meter Digital Contest RTTY

14/03/2015 12:00 14/03/2015 17:00 DIG QSO Party (10-20m) SSB

14/03/2015 14:00 14/03/2015 20:00 AGCW QRP Contest CW

14/03/2015 16:00 15/03/2015 16:00 EA PSK63 CONTEST PSK63

14/03/2015 18:00 15/03/2015 07:59 TESLA Memorial HF CW Contest CW

15/03/2015 00:00 15/03/2015 04:00 North America Sprint Contest RTTY

15/03/2015 07:00 15/03/2015 09:00 DIG QSO Party (80m) SSB

15/03/2015 07:00 15/03/2015 11:00 UBA Spring Contest 2m CW/Phone

15/03/2015 09:00 15/03/2015 11:00 DIG QSO Party (40m) SSB

15/03/2015 18:00 16/03/2015 01:00 Wisconsin QSO Party CW/Phone

16/03/2015 18:00 16/03/2015 20:59 Bucharest Contest CW/SSB

21/03/2015 02:00 23/03/2015 02:00 BARTG HF RTTY Contest RTTY

21/03/2015 12:00 22/03/2015 12:00 Russian DX Contest SSB/CW

21/03/2015 16:00 22/03/2015 15:59 BDM RTTY Contest RTTY

22/03/2015 00:00 22/03/2015 04:00 North America Sprint Contest SSB

22/03/2015 07:00 23/03/2015 11:00 UBA Spring Contest 80m SSB

28/03/2015 00:00 29/03/2015 23:59 CQ WW WPX Contest SSB

28/03/2015 00:00 29/03/2015 23:59 VERON SLP Contest - Part 3 SWL
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A. SO-AB-CW-LP
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog TROFEU
I YO5LD MM 1065 807 165 3872 638880 209 Trofeu oferit de sponsor

II YO4RDW VN 855 675 133 3138 417354 147

III YO5AIR BH 692 572 132 2658 350856 96

4 YO2CJX CS 710 560 127 2622 332994 110

5 YO2GL TM 592 490 112 2442 273504 80

6 YO5OHY MM 695 518 112 2420 271040 127

7 YO2BLX AR 582 480 114 2228 253992 87

8 YO4ATW BR 538 432 112 2098 234976 93

9 YO8COQ IS 536 409 109 1956 213204 95

10 YO8OU IS 533 393 105 1884 197820 99

11 YO5DAS SM 530 426 96 1922 184512 81

12 YO6LV MS 401 308 92 1510 138920 73

13 YO8RIX BT 301 262 78 1152 89856 32

14 YO2LDU AR 303 235 73 1112 81176 47

15 YO4AJ TL 296 235 72 1086 78192 44

16 YO9CWY BZ 238 216 68 1066 72488 18

17 YO7AWZ DJ 272 193 72 996 71712 57

18 YO2QY HD 210 161 84 820 68880 34

19 YO3JOS BU 289 241 60 1046 62760 39

20 YO4TL GL 225 189 57 780 44460 29

21 YO5NY CJ 212 164 55 776 42680 35

22 YO2ADQ TM 171 122 59 640 37760 34

23 YO4GVC CT 130 110 53 546 28938 15

24 YO4AH BR 165 117 49 584 28616 28

25 YO7NW GJ 70 61 28 312 8736 5

26 YO7CKQ GJ 59 41 20 166 3320 16

B. SO-AB-CW-HP
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog TROFEU
I YO5BRZ BH 699 543 125 2568 321000 118 Trofeu oferit de YO9HP

II YO2DFA CS 553 460 132 2246 296472 86

III YO8AXP BC 563 463 104 2210 229840 79

YO DX HF 2014 CONTEST
CAMPIONATUL NAŢIONAL 

MULTIBAND
CLASAMENT
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C. SO-AB-SSB-LP
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog TROFEU
I YO5OBA BH 493 293 94 1364 128216 184 Trofeu oferit de sponsor

II YO7CDB GJ 414 312 83 1422 118026 91

III YO2LOJ TM 262 222 73 1038 75774 33

4 YO5DDD AB 279 212 74 994 73556 52

5 YO5OHC SM 214 184 69 888 61272 24

6 YO8PN NT 235 188 62 864 53568 42

7 YO3DIU BU 210 165 71 752 53392 37

8 YO8RZJ BC 211 178 65 818 53170 27

9 YO3BY PH 323 202 54 910 49140 110

10 YO5ER BN 273 193 50 976 48800 73

11 YO9IXC BZ 194 166 61 798 48678 24

12 YO4US BR 209 182 55 862 47410 23

13 YO9IAB PH 159 134 56 628 35168 22

14 YO5CYG SM 167 133 57 612 34884 32

15 YO9HG PH 177 134 48 612 29376 37

16 YO6PEG SB 132 113 47 570 26790 14

17 YP9L PH 190 129 44 592 26048 58

18 YO2CXJ HD 190 137 42 612 25704 40

19 YO2MNE TM 194 126 43 594 25542 53

20 YO8PS IS 129 113 42 552 23184 16

21 YO6OBG MS 120 89 44 412 18128 20

22 YO2LXW HD 112 94 39 452 17628 11

23 YO8CQR NT 109 81 39 438 17082 5

24 YO9IOE PH 106 90 39 436 17004 13

25 YO7FEY GJ 92 80 44 360 15840 11

26 YO9RAO BZ 98 87 38 408 15504 10

27 YO4BXX CT 106 76 40 356 14240 21

28 YO9CKJ GJ 100 76 37 352 13024 15

29 YO4GPC BR 84 68 27 360 9720 10

30 YO8COK/PTL 72 60 27 324 8748 7

31 YO8CKR SV 69 45 32 196 6272 14

32 YO2MTG TM 52 41 28 192 5376 8

33 YO7HBY VL 61 47 23 220 5060 11

34 YO8CJY SV 47 37 23 172 3956 9

35 YO2LGS TM 38 33 17 162 2754 2

36 YO2MKK CS 33 23 11 122 1342 6

37 YO2MOH TM 17 16 14 80 1120 1

D. SO-AB-SSB-HP
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog TROFEU
I YP0C GL 1102 465 127 2202 279654 620 Trofeu oferit de YO HD ANTENA DX 

II YO3XX BU 830 453 112 2146 240352 357

III YO9XC BZ 441 275 76 1290 98040 149

4 YO3HEB PH 290 237 70 1166 81620 41
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5 YO3RU BU 473 214 41 998 40918 249

6 YO7BEM AG 142 116 52 542 28184 19

7 YO7CJB GJ 140 112 43 506 21758 24

8 YO5TP CJ 150 113 39 552 21528 33

9 YO2MBG AR 108 90 35 442 15470 12

10 YO9GMI PH 71 64 37 336 12432 6

E. YN
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog CLUBUL SPORTIV TROFEE
I YP3A BU 372 231 72 1052 75744 127 Palatul Naţional  Medalie aur

         al Copiilor oferită de YO9BC

II YO8TLK NT 8 6 6 28 168 2 Ceahlăul Piatra-Neamţ Medalie argint 

          oferită de YO9BC

F. SO-AB-MX-LP
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog CLUBUL SPORTIV TROFEE
I YO3FRI IF 944 723 149 3498 521202 191 CSTA BUCUREŞTI Tricou campion 

          + medalie aur

II YO9AGI DB 720 591 111 2698 299478 111 Petrolul Bucureşti Medalie argint

III YO4FZX TL 688 533 113 2456 277528 140 Delta Jandarmi Tulcea Medalie bronz

4 YO4KCC TL 585 466 103 2152 221656 80 Delta Jandarmi Tulcea

5 YO8WW NT 463 325 87 1526 132762 116 Ceahlăul Piatra-Neamţ

6 YO5CUQ CJ 271 227 68 1072 72896 30 C.S.M. Cluj-Napoca

7 YO7ARY VL 303 233 69 1042 71898 43 C.S.M. Craiova

8 YO3GCL BU 260 185 74 872 64528 52 CSTA Bucureşti

9 YO7LYM DJ 242 117 48 496 23808 77 C.S.M. Craiova

10 YO8MI BC 155 117 36 584 21024 22 C.S.M. Bacău

11 YO4HHP BR 111 94 42 456 19152 12 C.S.R. Brăila

12 YO2MCK TM 100 82 48 376 18048 9

13 YO6DBL CV 73 60 35 264 9240 9 Universitatea Braşov

14 YO4RST VN 57 50 22 288 6336 6 Ceahlăul Piatra-Neamţ

G. SO-AB-MX-HP 
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog CLUBUL SPORTIV TROFEE
I YP9W DB 1748 1255 198 6002 1188396 403 Petrolul Ploieşti Tricou campion 

           + medalie aur

II YR5N MM 1155 845 165 4136 682440 262 C.S.M. Baia-Mare Medalie argint

III YO4DW CT 1110 845 147 4122 605934 231 Rc. Radu Bratu Constanţa Medalie bronz

4 YQ6A CV 1091 852 141 4004 564564 191 KSE SportKlub Tg. Secuiesc

5 YO2LEA AR 731 576 116 2756 319696 121 Admira Arad

6 YO4SI CT 441 377 96 1826 175296 56 Rc. Radu Bratu Constanţa

7 YO9IF PH 290 217 77 1136 87472 61 AS Radioclubul Municipal Câmpina

8 YO7LGI VL 250 195 60 916 54960 38 C.S.M. Craiova

9 YO9HZN DB 121 102 48 488 23424 14 AS Radioclubul Elevilor Târgovişte

10 YO9GDN DB 50 40 16 248 3968 7

11 YO4SFW GL 56 40 18 188 3384 6 Glaris Galaţi
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H. SO-SB-MX-80
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog TROFEU

I YO9FLD BU 247 185 32 808 25856 35 Trofeu oferit de YO2DFA

II YO2AQB TM 244 178 32 756 24192 48

III YO2AQO TM 168 125 26 512 13312 30

4 YO8BGE NT 33 28 13 112 1456 2

H. SO-SB-MX-40
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog TROFEU

I YO7CVL AG 551 387 45 1768 79560 131 Trofeu oferit de sponsor

II YO5DAE SJ 505 368 42 1644 69048 116

III YO2LSR CS 214 166 33 724 23892 40

4 YO4CSG CT 68 56 25 248 6200 9

5 YO2MJZ AR 59 55 22 240 5280 4

6 YO6XK SB 61 51 19 232 4408 7

7 YO9RIJ BZ 73 49 15 196 2940 17

8 YO3YX BU 40 15 11 68 748 22

H. SO-SB-MX-20
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog TROFEU

I YO3ND BU 835 530 51 2424 123624 270 Trofeu oferit de sponsor

II YO9HP PH 673 465 53 2146 113738 189

III YO8TNB BT 543 362 52 1720 89440 157

4 YO4CAH TL 621 393 48 1756 84288 182

5 YO6FGZ CV 410 295 44 1380 60720 92

6 YO4BEX BR 312 208 39 952 37128 81

7 YO3CBZ BU 241 190 36 950 34200 43

8 YO2LYN CS 228 158 33 756 24948 63

9 YO3FGO BU 342 147 b34 694 23596 156

10 YO7YO VL 256 175 33 672 22176 56

11 YO4CAI BR 208 127 32 590 18880 44

12 YO3IMD BU 226 129 27 588 15876 93

13 YO8BDV SV 168 115 29 530 15370 42

14 YO8SKY SV 181 104 30 488 14640 76

15 YO2LEL TM 116 98 29 460 13340 16

16 YO2MAB AR 160 106 26 482 12532 39

17 YO8RFK SV 141 75 22 348 7656 54

18 YO2LFP AR 105 75 18 364 6552 27

19 YO2BPZ HD 41 32 15 152 2280 6

20 YO3AAS BU 30 25 15 124 1860 2

21 YO3AS BU 25 21 16 92 1472 4
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H. SO-SB-MX-15
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog TROFEU
I YO2RR TM 415 330 50 1736 86800 76 Trofeu oferit de sponsor

II YO3JW BZ 260 188 41 1052 43132 47

III YO2IS TM 191 164 37 934 34558 18

4 YO3FFF TR 140 119 32 688 22016 14

5 YO9CXE BZ 88 64 20 344 6880 17

H. SO-SB-MX-10
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog TROFEU
I YO2BBT CS 37 28 16 140 2240 7 Trofeu oferit de YO3JW

       

I. MO-AB-MX
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog CLUBUL SPORTIV TROFEE
I YR1C CT 1712 1278 206 6138 1264428 390 Rc. Radu Bratu Constanţa Tricouri 

          campioni

          +medalii aur

II YR9F GR 1696 1202 206 5728 1179968 403 Petrolul Ploieşti Medalii argint

III YP8T SV 1421 1079 195 5290 1031550 310 CSTA Suceava Medalii bronz

4 YP5A BN 1204 936 163 4566 744258 225 C.S.M. Bistriţa

5 YO8KGL BT 1223 888 141 4192 591072 292 C.S.M. Botoşani

6 YO7KFA AG 1047 749 139 3602 500678 225 C.S.M. Piteşti

7 YO8KVS VS 945 705 143 3408 487344 212 CSTA Suceava

8 YO6KNE HR 965 744 137 3508 480596 185 Sport Club Miercurea-Ciuc

9 YP7P GJ 991 672 134 3180 426120 267 C.S.M. Craiova

10 YO4KAK BR 622 543 99 2582 255618 72 C.S.R. Brăila

11 YP2DX TM 547 398 69 1806 124614 124

12 YO4KBJ GL 394 289 81 1428 115668 73 Glaris Galaţi

13 YO6KNY CV 315 251 89 1250 111250 48 KSE SportKlub Tg. Secuiesc

M. MM
LOC CALL JUD QSO QSOOK MLT PCT TOT NotLog TROFEU
I YO4FTE/MM AA 105 40 18 240 4320 11 Medalie aur oferită de YO2DFA

CHECK LOG
 CALL JUD QSO QSOOK MLT PCT TOT NotLog
 YO8SS SV 1023 776    201

 YO8SXX SV 469 369    89

 YO9CB PH 276 225    40

 YO3LW BU 245 199    42

 YO8TTT SV 139 124    11

 YO9KPM TR 16 14    1

 YO9OC PH 20 11    7






